GDAy 2.1

GDA94 Datum Transformation Software
User’s Guide

12/08/2016
# Table of contents

1. **INTRODUCTION** ............................................................................................................................ 1
   1.1 Overview ......................................................................................................................................... 1
   1.2 What's New in GDAy 2.1 ................................................................................................................ 1
   1.3 A Note on Bi-Linear Interpolation and Distortion Grids ............................................................... 2

2. **INSTALLING GDAy** ....................................................................................................................... 4
   2.1 General ........................................................................................................................................... 4
   2.2 Minimum Requirements ................................................................................................................. 4
   2.3 Windows Installation ....................................................................................................................... 5
      2.3.1 Sample Files ............................................................................................................................ 5
   2.4 Administrative or Network Installation ............................................................................................ 6
   2.5 Modify, Repair or Remove GDAy 2.1 ............................................................................................. 7

3. **GETTING STARTED** ..................................................................................................................... 8
   3.1 The Main GDAy Dialog ................................................................................................................... 8
   3.2 Running GDAy for the First Time ................................................................................................... 9
   3.3 Understanding the Menu Structure ................................................................................................ 9
      3.3.1 File Menu ................................................................................................................................. 9
      3.3.2 Transform Menu ..................................................................................................................... 12
      3.3.3 Tools Menu ............................................................................................................................ 12
      3.3.4 Help Menu ............................................................................................................................. 13
      3.3.5 Context Menus ...................................................................................................................... 14
   3.4 Using On-Line Help to Obtain Information ................................................................................... 15

4. **TRANSFORMING COORDINATES** ............................................................................................ 16
   4.1 Selecting a Distortion Grid ............................................................................................................ 16
   4.2 Changing the Coordinate System Parameters ............................................................................. 18
   4.3 Transforming a Single Point ......................................................................................................... 20
   4.4 Transforming Files ........................................................................................................................ 21
      4.4.1 Transforming a Single File ............................................................................................ 21
      4.4.2 Transforming Multiple Files in a Folder ............................................................................. 23
      4.4.3 Transforming Multiple Folders of Files ............................................................................. 24
      4.4.4 Supported File Types ........................................................................................................... 26
      4.4.5 Formatting Options for Geographic Coordinates in DAT, TXT, PRN and CSV files ....... 27

5. **UNDERSTANDING GDAy OUTPUT FILES** ................................................................................ 31
   5.1 Interactive Output File .................................................................................................................. 31
      5.1.1 Create a New Output File ...................................................................................................... 32
      5.1.2 Viewing and Printing the Output File ................................................................................... 32
   5.2 GDAy Log File ................................................................................................................................ 33
5.2.1 Viewing and Printing the Log File ................................................................. 34

6 CUSTOMISING GDAy ............................................................................................ 35
   6.1 GDAy View Options ....................................................................................... 35
   6.2 Interactive Output File Options ..................................................................... 37
   6.3 Log File Options ............................................................................................ 38

7 ERROR RETURN MESSAGES ............................................................................... 41
   7.1 Distortion Grid File Errors ............................................................................ 41
   7.2 File Transformation Errors .......................................................................... 42

8 WORKING WITH NTv2 DISTORTION GRIDS .................................................. 44
   8.1 View the Default Distortion Grid’s Properties .............................................. 44
   8.2 Export the Default Distortion Grid File ....................................................... 45
   8.3 Extract part of a Grid with Grid Extractor .................................................. 45

APPENDIX A – DAT, TXT, PRN and CSV FILE FORMAT SPECIFICATION ................. 46
   A.1 Formatted Text Files (*.dat, *.txt, *.prn) ....................................................... 46
   A.2 Comma Separated Files (*.csv) ...................................................................... 47

APPENDIX B – NTv2 GRID SHIFT FILE FORMAT ................................................ 50
   B.1 NTv2 Grid Shift File Concept ....................................................................... 50
   B.2 NTv2 File Format .......................................................................................... 52
      B.2.1 Grid Shift File Overview ......................................................................... 53
      B.2.2 Sub Grid Format .................................................................................... 54
   B.3 Necessary Considerations for NTv2 Usage .................................................. 55
      B.3.1 Difference Between Australian and Canadian Binary Files .................. 55
      B.3.2 Implications of Using NTv2 Outside Canada ......................................... 57

APPENDIX C – GDAy 2.1 SOFTWARE LICENSE AGREEMENT .................................. 58

Table of figures

Figure 3a – The main GDAy dialog ........................................................................ 8
Figure 3b – The File Menu .................................................................................... 10
Figure 3c – Distortion Grid Settings Pop-up Menu ............................................. 10
Figure 3d – Interactive Input Pop-up Menu ........................................................ 11
Figure 3e – Transform Menu .............................................................................. 12
Figure 3f – Tools Menu ....................................................................................... 12
Figure 3g – The Help Menu .............................................................................. 14
Figure 4a – Select Distortion Grid Dialog Box .................................................. 16
Figure 4b – Coordinate System Dialog Box ....................................................... 19
Figure 4c – The Output Zone prompt ................................................................. 19
Figure 4d – The Points File Transformation Dialog Box .................................... 22
Table of tables

Table 2a – Typical installation of core program and help files .......................................................... 5
Table 2b – Typical installation of sample files .................................................................................. 6
Table 4a – Transformation Parameters ............................................................................................ 17
Table 4b – Create Folder Prompt Options ....................................................................................... 26
Table 4c – Available File Conversions ............................................................................................. 27
Table 5a – Interactive Output Data Fields ......................................................................................... 31
Table 6a – Output Coordinates Precision ......................................................................................... 36
Table 8a – Grid Parameters Dialog Information ................................................................................. 44
Table A1 – DAT File Compulsory Items ............................................................................................ 46
Table A2 – CSV File Compulsory Items ............................................................................................ 47
Table B1 – Grid Shift File Data Types ............................................................................................... 53
Table B2 – Grid Shift File Overview Information .............................................................................. 53
Table B3 – Sub Grid Overview Information ....................................................................................... 54
Table B4 – Sub Grid Node Values ...................................................................................................... 55
1. INTRODUCTION

1.1 Overview

In November 1995, the Intergovernmental Committee on Surveying and Mapping (ICSM) recommended the progressive Australia-wide implementation of a new national geodetic datum to be introduced by January 1, 2000. This datum is known as the Geocentric Datum of Australia (GDA94).

In recognition of the vast number of spatial data users across Queensland wishing to transform their coordinates to the new datum, the Department of Natural Resources and Mines (DNRM) developed a datum transformation program titled "GDAy" that runs under 32-Bit and 64-Bit versions of Windows. The release of version 2.1 contains additional features and amendments to the core program files, and provides greater flexibility for modern Windows operating systems and administrator-controlled domains.

GDAy transforms coordinates between the Australian Geodetic Datum (AGD66 or AGD84) and the Geocentric Datum of Australia, 1994 (GDA94). GDAy supports both high accuracy datum transformations (bi-linear interpolation from a grid of coordinate shifts) and medium accuracy datum transformations (conformal 7-parameter). Since the application of bi-linear interpolation is directly related to the region covered by the distortion grid, GDAy may be used anywhere throughout Australia provided an appropriate grid is selected.

With GDAy, users can perform datum transformations and coordinate conversions using geographical coordinates (i.e. Latitude and Longitude) or projection coordinates (i.e. Easting, Northing and Zone), whether working on one datum or between AGD66 or AGD84 and GDA94. Coordinates may be transformed by entering values in the main GDAy dialog or by file input.

The supported file types include:

- Formatted Text Files (*.dat, *.prn, *.txt).
- Comma Separated Values Files (*.csv).
- QLD Survey Control Database (SCDB) MAN Files (*.man).
- Queensland Interchange Format (QIF) Files, Version 3 (*.qif).
- NEWGAN Res Files (*.res).

1.2 What’s New in GDAy 2.1

Version 2.1 of GDAy has a new look and feel, and incorporates many additional features and amendments to the core program files. It has been developed specifically to cater for new versions of Windows and provides greater flexibility when running on administrator-controlled domains.

The major improvements to the program include:

- The ability to transform entire folders and their containing subfolders.
The ability to abort transformations involving more than one file or folder.

Greater flexibility when inputting formatted text and comma separated values.

Additional file transformation options that allow you to omit the inclusion of standard headers and force the output coordinates onto a specified zone.

The inclusion of Grid Extractor, which can be used to create new distortion grid files for a user defined area or location.

A new version of the transformation library (gcalc.dll), providing additional methods to developers writing customised applications.

Additional National AGD66 parameters for Australia, allowing you to convert old AGD66 data in areas where the new National AGD66 grid does not cover.

Upgrade of the user interface, incorporating additional system menu items, context menus, status bars and progress bars (for lengthy file output).

Improved access to GDAy help information through HTML Help.

The use of Windows Installer and the msi package file format to perform the software installation, configuration and removal.

The amendments to known problems include:

- Support for current user and local machine installation configurations.
- Support for standard users who have limited access privileges on network controlled domains.
- Corrections to the printing of transformation output files where certain data fields were being incorrectly truncated.

### 1.3 A Note on Bi-Linear Interpolation and Distortion Grids

The recommended approach in Australia for transforming coordinates between AGD66/AGD84 and GDA94 is to use **bi-linear interpolation**. This is a **High Accuracy** approach, requiring a standard grid of coordinate differences that model the AGD66/AGD84 to GDA94 transformation and AGD66/AGD84 network distortions. The Canadian National Transformation Version 2 (NTv2) is adopted as the standard file format for the grid of coordinate differences. Appendix B provides a detailed explanation of the NTv2 grid shift file format.

The latest version of the Queensland grid file is installed in the same folder as the GDAy software and is titled "QLD_0900.gsb". This replaces the existing grid "QLD_0400.gsb". All Australian States and Territories currently have a grid file(s) covering their area. These grid files will transform from either AGD66 or AGD84, depending on which version of AGD was previously adopted by that jurisdiction. For instance, "QLD_0900.gsb" can only be used to transform coordinates between AGD84 and GDA94.
GDAy can be used to transform coordinates using any grid file in the NTv2 format developed for transforming coordinates in Australia between AGD66/AGD84 and GDA94.

For a complete coverage of Australia, you can download the latest national distortion grid files from:

**National AGD66 to GDA94:**
3.10 MB download file

**National AGD84 to GDA94:**
7.74 MB download file

If this method of obtaining the required grid file is inconvenient, contact your state’s Land Administration Agency for assistance. Note that the Queensland grid QLD_0900.gsb produces identical results to the National AGD84 grid for the equivalent coverage.

For further information relating to the technical standard and implementation issues of transforming to GDA94, visit ICSM’s GDA website:
2 Installing GDAy

2.1 General

The GDAy 2.1 Setup Wizard uses Windows Installer to manage the deployment and configuration of all software features and components. The Setup Wizard will determine whether the installer is present on your computer, and if it is not present, it will attempt to install Windows Installer.

As published by Microsoft:

- Windows Installer is an installation and configuration service that is included in Microsoft Windows 2000, Windows XP, and Windows Millennium Edition (Windows Me) operating systems, and is provided in a service pack to Windows 95, Windows 98, and Microsoft Windows NT 4.0.
- Windows Installer manages the installation, addition, and deletion of software components, monitors file resiliency, and maintains basic disaster recovery by way of rollbacks.
- Using Windows Installer is the recommended approach for installing programs on your computer.

If you have installed Microsoft products such as Office 2000 (or any of its components), Windows Installer will be present on your computer. In this case, the GDAy Setup Wizard will run as normal without altering your system.

2.2 Minimum Requirements

GDAy can only be run under 32-bit versions and 64-bit versions of Windows. You cannot run GDAy under 16-bit versions of Windows (i.e. Windows 3.1 or Windows 3.11) nor on any Macintosh or Linux platforms.

Before you can install and run GDAy, check that your PC meets the following minimum software and hardware requirements:

1. 4.5 MB of free hard-disk space.
2. 2 MB RAM.
3. 80486 processor or better.

Before you can install GDAy, you will need to have elevated-user or administrator privileges. These privileges enable you to install software on your computer and are usually set by your local system administrator. If you are unsure whether you have such privileges or not, contact your local system administrator for assistance.
2.3 Windows Installation

To install GDAy on your computer

1. Click Start, point to Settings, click Control Panel, and then open Add/Remove Programs.
2. Click Add New Programs, and then click CD or Floppy.
3. Follow the instructions on your screen. You will need to locate Setup.exe.
4. The GDAy 2.1 Setup Wizard will guide you through the installation.

If you have installed Grid Extractor or previous versions of GDAy on your computer, such as GDAy 2.0 or GDAy 1.0, the Setup Wizard will prompt you to remove these programs. The Setup Wizard can remove both versions automatically without requiring you to exit. During this process, you will be required to click OK when each program is removed. If you prefer to uninstall these versions manually, cancel the Setup Wizard and return to the Setup Wizard when you are ready.

During a typical installation, the Setup Wizard will copy the core program and help files to the nominated folder (the default is C:\program Files\GDAy 2.1). These files are shown in Table 2a.

Table 2a – Typical installation of core program and help files.

<table>
<thead>
<tr>
<th>File Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GDAy.exe</td>
<td>Performs datum and coordinate transformations between AGD and GDA</td>
</tr>
<tr>
<td>GDAy.chm</td>
<td>Online resource for datum and coordinate transformations</td>
</tr>
<tr>
<td>GCalc.dll</td>
<td>Transformation library</td>
</tr>
<tr>
<td>QLD_0900.gsb</td>
<td>Queensland distortion grid</td>
</tr>
<tr>
<td>GDAy2.1 User’s Guide.pdf</td>
<td>This document in Adobe PDF</td>
</tr>
<tr>
<td>GridEx.exe</td>
<td>Creates NTv2 distortion grid files for a user defined area or location</td>
</tr>
<tr>
<td>GridEx.hlp</td>
<td>Online resource for NTv2 grid file extractions</td>
</tr>
<tr>
<td>GridEx User’s Guide.pdf</td>
<td>Grid Extractor user documentation and technical reference in Adobe PDF</td>
</tr>
<tr>
<td>Readme.htm</td>
<td>A Short help file to assist you in installing GDAy and obtaining technical support</td>
</tr>
</tbody>
</table>

2.3.1 Sample Files

During installation, you have the choice to install some sample files. If you chose to install the sample files, twelve coordinate files for use by GDAy will be installed to a folder called Sample Files, which is located in the folder where GDAy was installed. The samples are provided to demonstrate the file format requirements for each coordinate type supported by GDAy.
During a typical installation, the Setup Wizard will copy the sample files to the nominated folder (the default is C:\program Files\GDAy 2.1\Sample Files). These files are shown in Table 2.

### Table 2b – Typical installation of sample files

<table>
<thead>
<tr>
<th>File Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AGD84_UTM.dat</td>
<td>Projection Coordinates (DAT file)</td>
</tr>
<tr>
<td>AGD84_DDEG.dat</td>
<td>Decimal Degrees (DAT file)</td>
</tr>
<tr>
<td>AGD84_HPDM.dat</td>
<td>Degrees Minutes Seconds in HP Notation (DAT file)</td>
</tr>
<tr>
<td>AGD84_SEPDM.dat</td>
<td>Separated DMS fields (DAT file)</td>
</tr>
<tr>
<td>AGD84_HPDMIN.dat</td>
<td>Degrees Minutes in HP Notation (DAT file)</td>
</tr>
<tr>
<td>AGD84_SEPDMIN.dat</td>
<td>Separated DM fields (DAT file)</td>
</tr>
<tr>
<td>AGD84_UTM.csv</td>
<td>Projection Coordinates (CSV file)</td>
</tr>
<tr>
<td>AGD84_DDEG.csv</td>
<td>Decimal Degrees (CSV file)</td>
</tr>
<tr>
<td>AGD84_HPDM.csv</td>
<td>Degrees Minutes Seconds in HP Notation (CSV file)</td>
</tr>
<tr>
<td>AGD84_SEPDM.csv</td>
<td>Separated DMS fields (CSV file)</td>
</tr>
<tr>
<td>AGD84_HPDMIN.csv</td>
<td>Degrees Minutes in HP Notation (CSV file)</td>
</tr>
<tr>
<td>AGD84_SEPDMIN.csv</td>
<td>Separated DM fields (CSV file)</td>
</tr>
</tbody>
</table>

You can choose not to install these files during a Custom Installation and, if you have already installed them onto your computer, you may remove them at any time by using the GDAy Setup Wizard from Control Panel, Add/Remove Programs.

### 2.4 Administrative or Network Installation

The GDAy 2.1 Setup Wizard can perform an administrative installation to a network for use by a workgroup. The administrative installation installs a source image of GDAy onto the network that is similar to the source image of the original CD-ROM. Users in a work group who have access to this image can then install GDAy from this location.

To create a server image of GDAy 2.1 at a specified network location

1. Log on to the server with administrator rights.
2. At the command prompt, type `<source location>\setup.exe /a`
3. The GDAy 2.1 Setup Wizard will ask you for a destination folder, in which case you should select a new, empty directory on the server.
4. The Setup Wizard will guide you through the rest of the installation.
During installation, setup will copy all program files plus the Setup Wizard files to this server directory.

To install GDAy for users in a workgroup:

1. From each workstation that will run GDAy, log onto the server with administrator rights.
2. Run GDay.msi located in the server directory. **DO NOT** run setup.exe from the CD.
3. When the GDAy 2.1 Setup Wizard asks for a destination folder, choose one from the workstation.

NOTE: Because GDAy requires read/write access to the system registry, it must be installed on a workstation and not a server directory.

### 2.5 Modify, Repair or Remove GDAy 2.1

The GDAy 2.1 Setup Wizard can modify, repair or remove an existing installation of GDAy 2.1. The Setup Wizard allows you to customise an installation, by providing you with the option to install or remove individual features, and can restore any deleted or corrupted files without having to completely reinstall GDAy.

To modify, repair or remove GDAy 2.1:

1. Click **Start**, point to **Settings**, click **Control Panel**, and then open **Add/Remove Programs**.
2. Select GDAy 2.1 from the installed programs.
3. Perform one of the following options:
   - Click **Add/Remove** or **Remove** to remove GDAy 2.1 from your computer.
   - Click **Change/Remove** or **Modify** to add or remove individual features of GDAy.
   - Click **Support information** and then click **Repair** to install any deleted or corrupted files.

In these instances, if the program was installed from a CD-ROM or if you are no longer connected to the network, Windows Installer may ask you for the CD-ROM.

When you attempt to run GDAy, Grid Extractor or any other item from the **Start Menu - Programs** group, you may see a dialog box indicating that GDAy is being installed or updated by Windows Installer. This can occur if your administrator has set up the program to install this way, if program files have been deleted or corrupted, or if you are trying to use a program feature that was not installed during Setup.
3   GETTING STARTED

3.1 The Main GDAy Dialog

Figure 3a shows the main GDAy dialog. At the top-left of the dialog is the main menu. You can use this menu to select the appropriate distortion grid, transform files of coordinates, select the input and output coordinate system parameters, customise certain settings for personalised usage, and to view the on-line help. For more information on the available menu items, see "3.3 Understanding the Menu Structure".

The remaining control items on the dialog are for transforming coordinates for a single point. The first edit box on the left is for point numbering. Since you can have all transformed points printed to an interactive output file, numbering each point enables you to uniquely identify them from a list. The use of point numbering is not essential for the transformation of coordinates and can be turned on or off at any time. For more information on the options for controlling how you can use point numbering, see "6.1 GDAy View Options".

The input and output coordinate edit boxes are for entering in the desired coordinates and displaying the transformed values respectively. You can work in geographic coordinates of latitude and longitude or projection coordinates of easting, northing and zone. The transformed (output) coordinates can be displayed to varying precision relevant to your use. The edit boxes on the far right are used to display the interpolation accuracy derived from the transformation process. When transformations are
performed through the edit boxes on this dialog, the action is known as an **interactive transformation**.

The information relating to datum and coordinates displayed in the input and output group boxes is provided to keep the user informed of the current coordinate system parameters. This information reflects the selection made from the coordinate system parameters. To choose the desired coordinate system parameters, see "4.2 Changing the Coordinate System Parameters".

The status bar on the bottom of the dialog contains three panes. These panes display a short description for each selected menu item, the file name of the default distortion grid and the file name of the default interactive output file. To modify the location and filename of either the default grid file or the output file, right click on the respective pane and select one of the available menu items.

Each time **Compute** is pressed the input and transformed output coordinates are printed to this file. To change the default location of this file or to create a new interactive output file, see "6.2 Interactive Output File Options".

3.2 Running GDAy for the First Time

Since the use of bi-linear interpolation is directly related to the region covered by the distortion grid, you need to select a distortion grid that covers the area you are working in. When you install GDAy, the latest version of the Queensland Distortion Grid will be copied to the folder where GDAy is installed. The Setup program will allow you to select the Queensland Distortion Grid as the default grid. If you choose to use the Queensland Distortion Grid, the AGD84 – GDA94 National parameters will be selected as the default transformation parameters.

If you choose not to use the Queensland Distortion Grid, when you run GDAy for the first time you will be prompted to select a distortion grid that covers the area you are working in and the transformation parameters to be used only when a point lies outside the limits of the grid.

For more help on selecting a distortion grid and transformation parameters, see “4.1 Selecting a Distortion Grid”.

Once you have selected the distortion grid, you are now ready to begin transforming coordinates. Note that once you have selected a distortion grid file, it becomes the default distortion grid for all subsequent transformations. You do not need to re-select the distortion grid after you close and run GDAy again.

3.3 Understanding the Menu Structure

3.3.1 File Menu

The **File** menu contains four main items to select from. Figure 3b shows the File menu.
Distortion Grid Settings

This pop-up menu contains four lower level menu items: Select New Grid File, Grid Properties, Export Grid File, and Run Grid Extractor. Figure 3c shows the Distortion Grid Settings pop-up menu.

Select New Grid File directs the user to another dialog for the purpose of choosing the default distortion grid and transformation parameters. The only supported NTv2 file types are ASCII (*.asc) and Binary (*.gsb) files. The transformation parameters are used in a conformal datum transformation only when a point lies outside the limits of the distortion grid.

Grid Properties displays the general and technical information about the default distortion grid.

Export Grid File contains two lower menu items: ...to ASCII and ...to Binary. Depending on the file type of the default distortion grid, you can export the grid file to either ASCII or Binary in the NTv2 file format. For example, if you have selected a Binary grid file, you will only be able to export it to ASCII format. Selecting either menu item displays a standard file-open dialog box from which the user can select the desired distortion grid file name. The only supported NTv2 file types are ASCII (*.asc) and Binary (*.gsb) files.
Run Grid Extractor activates Grid Extractor: a tool for creating NTv2 distortion grid files for a user-defined area or location. See “8.3 Extract Part of a Grid with Grid Extractor” for quick tips on using Grid Extractor.

For more information on using Grid Extractor, see “Grid Extractor User’s Guide.pdf”.

Interactive Input

This pop-up menu item contains two lower level menu items: New Output File and View Output File. Figure 3d shows the Interactive Input pop-up menu.

Figure 3d – Interactive Input Pop-up Menu.

Select New Output File to create a new interactive output file to store the output of all subsequent interactive transformations. Note that this does not change the Default output file. Select View Output File to open and view the current output file in a text editor such as Notepad. See “6.2 Interactive Output File Options” for more information on handling the default Interactive Output settings.

Transform Points File

This menu item directs the user to another dialog for the purpose of transforming coordinates using files instead of the main interface. When the user transforms coordinates through this menu item, the conversion is known as a points file transformation. For more information on transforming a file of coordinates, see “4.4 Transforming Files”.

Transform Folder

This menu item directs the user to another dialog for the purpose of transforming entire folders. This method of transforming files is similar to the Transform Points File option, however here you have the option of searching through an entire folder and all its subfolders to transform any files of the specified file type and coordinate format. For more information on transforming a file of coordinates, see “4.4 Transforming Files”.
Exit

As with most other applications, Exit closes GDAy.

### 3.3.2 Transform Menu

The Transform menu contains two menu items to select from; **AGD66/84 to GDA94**, and **GDA94 to AGD66/84**. Figure 3e shows the Transform menu.

![Transform Menu](image)

These menu items duplicate the functionality of the **Compute** button, however are available only when the items match the selected input and output coordinate system parameters. For example, if the input coordinates are in AGD66/84 and the output coordinates are in GDA94, only the first menu item (AGD66/84 to GDA94) is available.

Transforming coordinates in this direction is known as a **forward transformation**. Therefore, where a **reverse transformation** is required, the second menu item is only available when the input and output parameters are GDA94 and AGD66/84 respectively.

### 3.3.3 Tools Menu

This menu contains three items: **Coordinate System**, **Options** and **View Log File**. Figure 3f shows the Tools menu.

![Tools Menu](image)

**Coordinate System**
Coordinate System directs the user to another dialog for the purpose of selecting the input and output coordinate parameters. Whether for interactive or points file transformations, these parameters are used globally throughout GDAy. Select this menu item to choose the input and output datum (AGD or GDA) and the coordinates (geographic or projection) for all subsequent datum transformation and coordinate conversions.

For more information on selecting the input and output coordinate system parameters, see “4.2 Changing the Coordinate System Parameters”.

Options

Options directs the user to a 3-page dialog-box that enables general customising of the GDAy user interface and control over the interactive output file and log file settings. Select this option to customise the user settings for point numbering, auto format of edit boxes, working precision of output edit boxes, station naming, default file locations for the interactive output and log files, and header text information.

For more information on these topics, see “6.1 GDAy View Options”.

View Log File

View Log File opens the default log file in a text editor such as Notepad.

3.3.4 Help Menu

This menu contains four items: Contents, Index, Search and About GDAy 2.1. Figure 3g shows the Help menu.

Contents

Select this menu item to display the on-line help table of contents.

Index

Select this menu item to display the on-line help Index.
Search
Select this menu item to display the on-line help search facility.

About GDAy 2.1
Select this item to view information about the version, copyright and general software information.

3.3.5 Context Menus
When working on the main GDAy dialog, Points File Transformation dialog or Folder Transformation dialog, you have available a context menu that duplicates relevant items from the main menu. The menu items duplicated are View Log File, Tools, Distortion Grid Settings, and Interactive Output.

View Log File
From either the Points File Transformation dialog or Folder Transformation dialog, right click the dialog to display the View Log File menu item.

Tools
From the main GDAy dialog, right click anywhere on the main body to display the Tools menu.

Distortion Grid Settings
From the status bar on the main GDAy dialog, right click the distortion grid pane to display the Distortion Grid Settings sub menu.

Interactive Output
From the status bar on the main GDAy dialog, right click the interactive output pane to display the Distortion Grid Settings sub menu.
3.4 Using On-Line Help to Obtain Information

On-Line Help is provided for information related to using GDAy for transforming coordinates. The current version of HTML Help provides for a modern tree-view table of contents, index, advanced search facility and favourites. The favourites tab can be used to store bookmarks to pages you are most interested in.

When using GDAy, there are three ways to access the On-Line Help facility:

1. Anywhere throughout GDAy, you can press F1.
2. From the Help menu in the main GDAy dialog, select Contents, Index or Search.
3. From any other dialog where a Help button is available. This will display information related to the current dialog in the HTML Help viewer.
4 TRANSFORMING COORDINATES

4.1 Selecting a Distortion Grid

GDAy incorporates a distortion grid file to perform high accuracy coordinate transformations. To ensure that you will be achieving the most accurate coordinate transformations as possible, you need to select a distortion grid that covers an area your coordinates are within.

To select a new distortion grid file

1. On the File menu, point to Distortion Grid Settings, and then click Select New Grid File. This opens the Select Distortion grid dialog Box as shown by Figure 4a.
2. Click Browse.
3. In the Look in box, click the drive or folder that contains the distortion grid file.
4. In the Files of type box, choose the appropriate grid file-type or format (note: the available types include ASCII (*.asc) and Binary (*.gsb) files).
5. In the folder list, double-click folders until you open the folder that contains the file.
6. Double-click the distortion grid you want to use.
7. Click OK to accept the changes.

Figure 4a – Select Distortion Grid Dialog Box.

Once you have selected a valid distortion grid, the limits of the grid are displayed in geographic coordinates (degrees, minutes and seconds). Similarly, each time you click on Select New Distortion Grid from the File menu, the limits of the default Distortion Grid will be displayed here. Depending on the location of your coordinates, this will help you determine which distortion grid will be most appropriate for your area.
On accepting the changes made in the Select Distortion Grid dialog box, the distortion grid filename will be shown on the status bar of the main dialog. If the filename is too long to be displayed in the grid file status bar pane, a tool tip with the full filename will be shown when you move your mouse over it.

**Transformation Parameters**

Whenever you are transforming a single point or a file of points and the point being transformed lies outside the limits of the distortion grid, a 7-Parameter coordinate transformation may be performed. In this case, it is important that you select the most appropriate transformation parameters for your area of interest.

*Table 4a* lists the six different transformation parameters that may be used throughout Australia and, as their title suggests, which State(s) they should be used in.

**Table 4a – Transformation Parameters**

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Valid Jurisdiction</th>
</tr>
</thead>
<tbody>
<tr>
<td>AGD84 – GDA94 (National)</td>
<td>Queensland, South Australia, Western Australia only</td>
</tr>
<tr>
<td>AGD66 – GDA94 (National)</td>
<td>Queensland, South Australia, Western Australia only</td>
</tr>
<tr>
<td>AGD66 – GDA94 (A.C.T.)</td>
<td>Australian Capital Territory</td>
</tr>
<tr>
<td>AGD66 – GDA94 (Tasmania)</td>
<td>Tasmania</td>
</tr>
<tr>
<td>AGD66 – GDA94 (N.T.)</td>
<td>Northern Territory</td>
</tr>
<tr>
<td>AGD84 – GDA94 (Victoria/NSW)</td>
<td>Victoria and New South Wales</td>
</tr>
</tbody>
</table>

To select the desired transformation parameters

1. Open the Select Distortion Grid dialog box as described above.
2. From the **Parameters** drop-down combo box, click on the desired transformation parameters.
3. Click OK to accept the changes.

For example, when you are transforming AGD84 coordinates in Queensland you should be using the latest version of the Queensland distortion grid: “QLD_0900.gsb”. Where a point lies outside the distortion grid, you should be using the **AGD84 – GDA94 (National)** transformation parameters.

Note that there is some overlap in coverage for the National parameters listed above. This is a result of a re-adjustment of the Australian geodetic network in 1982 (known as the Geodetic Model of Australia 1982). The adjustment provided an improved measure of accuracy for Queensland, South Australian and Western Australia however, did not significantly improve the AGD66 coordinate set for the remaining states.
Therefore, the adopted coordinate set for the Northern Territory, Australian Capital Territory, New South Wales and Victoria remained as AGD66. The AGD66 parameters for Queensland, South Australia and Western Australia are provided to assist those in transforming old datasets that were not transformed to AGD84.

Once you have selected the distortion grid and transformation parameters, you are now ready to begin transforming coordinates. Note that once you have accepted any changes, the selected distortion grid and parameters become the default for all subsequent transformations. You do not need to re-select these settings after you close and run GDAy again.

4.2 Changing the Coordinate System Parameters

To change the coordinate parameters for all input and output data

1. On the Tools menu, click Coordinate System. This opens the Coordinate System dialog Box as shown by Figure 4b.

2. From the Datum drop-down combo box in the Input Coordinates group, click on the desired datum. If a new datum was selected, the input Coordinates will change to reflect the relevant types. Select the desired coordinates to be used.

3. If you selected geographic, you now have the option to work with degrees minutes and seconds; degrees and minutes, or; decimal degrees format (as given by the radio buttons). Otherwise, the three radio buttons will become greyed. This indicates that the coordinates are projected and that they will be displayed in metres.

4. Follow the same procedure above for the Output Coordinates group.

5. Click OK to accept the changes.
You may work with any possible combination of datum, coordinate and format settings. If the input and output datum settings are the same, then a datum transformation will not occur; only a conversion of coordinates will be performed. If Cancel is pressed, the original coordinate system parameters are retained. After closing and running GDAy at another time, the parameters you set previously will be retained.

If your output coordinates are projected and you would like to specify the zone in which they should be computed, select the Prompt for output zone check box. Each time a transformation is performed, whether by file or on the main GDAy dialog, you will be prompted to specify a zone. Figure 4c shows the dialog box for selecting the output zone when the datum for the output projected coordinates is GDA.

Specifying a unique zone will ensure that all transformed coordinates will be projected over a single zone, regardless of how far east and west the file spans. If Cancel is pressed, the default Zone is computed.
If you have selected the **Prompt for output zone** check box and you are transforming multiple files or folders, you can choose to have all output files projected on the same zone. After entering in a valid zone for the first file that is transformed, you will be prompted with a message box that asks you whether you would like to use the specified zone for all remaining files. Click **Yes** if you want all output coordinates projected to the same zone, or click **No** if you would like to specify a different zone for the coordinates in each new output file.

### 4.3 Transforming a Single Point

To transform a single point, make sure that the **Datum** and **Coordinates** information on the main GDAt dialog relates to the datum transformation and coordinate conversion that you want to do. If this information does not display the input and output parameters you require, then select **Tools | Coordinate System** to change the input and output coordinate system parameters.

If the desired parameters are displayed on the main GDAt dialog, simply enter the coordinates into the **Input Coordinates** edit-boxes on the left and press **Compute**. The transformed coordinates will appear in the **Output Coordinates** edit-boxes on the right. This form of transforming coordinates is known as an **interactive** transformation. Each time you press **Compute**, the input and output coordinates are printed to the interactive output file. See “5.1.2 Viewing and Printing the Output File” for more information.

The corresponding interpolation accuracy values are printed in the far right edit boxes. These values represent a measure of quality of the distortion grid in terms of its ability to model the actual distortion in that area. For example, if ± 0.050m is displayed, this means that the accuracy of the transformation (using the specified distortion grid) has been performed to within 50mm. It does not mean that the accuracy of the transformed coordinates is now ± 50mm.

If the accuracy values could not be determined, the edit boxes will contain 3 dashes: “ --- ”. This means that either the coordinates for the point were outside the limits of the distortion grid, or the specified distortion grid contains no interpolation accuracy information for the given area. In the instances where the input coordinates for a point are outside the specified distortion grid, a message box will be displayed prompting you to choose whether you would like to continue with a 7 Parameter transformation only. Where this occurs, the information displayed in the message box and the input coordinates are printed to the log file.

You can view all interactive transformations by selecting **File | Interactive Output | View Output File** to open the output file in in a text editor such as Notepad. To view the Log file, select **Tools | Options**, then from the Options dialog sheets, select the **Log File** tab. Click on **View** to open the log file in WordPad. From WordPad, you can print the file if necessary.
4.4 Transforming Files

To transform a file of points, make sure that the Datum and Coordinates information (displayed on the main GDAy dialog) relates to the type of datum transformation and coordinate conversion you require. If this information does not display the input and output parameters you require, then select Tools | Coordinate System to change the input and output coordinate system parameters. See "4.2 Changing the Coordinate System Parameters" for more information.

For successful file transformations, GDAy requires a structured format relating to each file type. This format relates to both the coordinate system parameters and how the data is stored within the file. For *.dat, *.txt or *.prn, *.csv, *.res and *.qif files, a file of points will not be transformed if the coordinates within the input file do not match the input coordinate system information displayed on the main dialog.

For example, if you have selected “Australian Map Grid (AMG 66/84)” from the Coordinate System dialog box, you must select a file that has coordinates of this type. A good habit to get into is to label the input and output files according to the type of coordinates that are stored within them.

If you are transforming a *.man file, you only need to ensure that the input and output Datum parameters are correct. Since *.man files contain both coordinate types (i.e. latitude & longitude; and easting, northing & zone), only the latitude and longitude are read from the input file. When the coordinates have been transformed, both the latitude & longitude; and easting, northing & zone are printed to the file.

For more information on the supported file types and available file conversions, see “4.4.4 Supported File Types”.

When transforming files using GDAy, you have three options: Transform a single file, Transform multiple files in a folder, or Transform multiple folders of files.

4.4.1 Transforming a Single File

To transform a single file of points:

1. On the File menu, select Transform Points File. This will display the Points File Transformation dialog box as shown in Figure 4d.
2. Click Browse.
3. In the Look in box, click the drive or folder that contains the input file.
4. In the Files of type box, choose the appropriate input file-type (note: the available types include Formatted Text (*.dat, *.prn, *.txt), Comma Separated Files (*.csv) files, QLD SCDB files (*.man), NEWGAN res files (*.res), and Queensland Interchange Format (*.qif) files).
5. In the folder list, double-click folders until you open the folder that contains the required file.
6. Double-click the input file you want to use.
7. If you are transforming a file of geographic coordinates in degrees, minutes and seconds, select the appropriate radio button from the Input File Group. This radio button option is
greyed when you are transforming SCDB files (*.man), NEWGAN Res files (*.res) or Queensland Interchange Format files (*.qif).

8. Click Save As.

9. Repeat steps 3 to 5 to select the output file.

10. If you want to print a file of geographic coordinates in degrees, minutes and seconds, select the appropriate radio button from the Output File Group.

11. Click **Write header to dat/csv output files** if you wish to have a standard header printed at the start of every Formatted Text or Comma Separated output file.

12. Click **OK**.

If you are transforming a Queensland Interchange Format file (*.qif) and the coordinates to be printed to the output file are projection coordinates, you will be prompted to specify a zone for the output file. Specifying a unique zone will ensure that all transformed coordinates will be projected over a single zone, regardless of how far east and west the file spans. Figure 4c shows the dialog box for selecting the output zone.

*Figure 4d – The Points File Transformation Dialog Box*

![Points File Transformation Dialog Box](image)

After the file has been successfully transformed, you will be prompted to transform another file. If at least one point in the input file could not be transformed, or an error occurred in the file-read/write process, a message box will be displayed to outline the problem that occurred. This message box information and the input coordinates are printed to the Log File. See "7. ERROR RETURN MESSAGES" for details on the various messages.
For formatted text and comma separated files only, the corresponding interpolation accuracy values are printed at the end of each line in the output file. If the accuracy values could not be determined, 3 dashes: “---” will be printed instead.

### 4.4.2 Transforming Multiple Files in a Folder

The procedure for transforming multiple files is similar to that of transforming a single file of points. An important note to make is that you cannot use this multiple file transformation function to transform Formatted Text or Comma Separated files that contain coordinates of different types. Similarly, all input files must be of the same file format.

To transform multiple files in a single folder:

1. On the **File** menu, select **Transform Points File**.
2. Click **Browse**.
3. In the **Look in** box, click the drive or folder that contains the input file.
4. In the **Files of type** box, choose the appropriate input file-type.
5. In the folder list, double-click folders until you open the folder that contains the required files.
6. Highlight all the input files you want to transform, and then click **OK**.
7. Select the appropriate radio button from the Input File Group.
8. Click **Write header to dat/csv output files** if necessary.
9. Click **OK**.

**Note** Upon selecting multiple files in step 5, the output **File Name** edit box, **Save As** button and the radio buttons are greyed to restrict you from any further file selection. Also, for every input file you selected, the output file names will be exactly that of the input file names with a ‘_’ character inserted at the front of the file name. For example, if you selected the files “AGD84_HP1.dat” and “AGD84_HP2.dat” the output file names will be “_AGD84_HP1.dat” and “_AGD84_HP2.dat” respectively.

If you have selected **Prompt for output zone** in the **Coordinate System** dialog box, or if you are transforming a Queensland Interchange Format file (*.qif) and the coordinates to be printed to the output file are projection coordinates, you will be prompted to specify a zone for each output file. See “4.2 Changing the Coordinate System Parameters” for more information.

After entering in a valid zone for the first file that is transformed, you will be prompted with a message box that asks you whether you would like to use the specified zone for all remaining files. Click **Yes** if you want all output coordinates projected to the same zone, or click **No** if you would like to specify a different zone for the coordinates in each new output file.

Figure 4e shows the dialog that prompts you to select the output zone for all remaining output files.
After the files have been successfully transformed, you will be prompted to transform another file. If at least one point in any of the input files could not be transformed, or an error occurred in the file-read/write process, the particular error details and the input coordinates are printed to the Log File.

### 4.4.3 Transforming Multiple Folders of Files

To transform a folder of files:

1. On the **File** menu, select **Transform Folder**. This will display the Folder Transformation dialog box as shown in Figure 4f.
2. Click **Look in**.
3. From the explorer tree, either click the drive or root folder that contains the input files, or type in the full folder path in the Folder box, and then click **OK**.
4. From the **File format** box in the Input Folder group, choose the extension that matches the input file-type you are working with.
5. If the selected coordinate system parameters specify that the input coordinates are geographic coordinates, then select the appropriate format type from the **Geographic format** box.
6. Click **Recurse subfolders** if you wish to transform all sub-folders contained within the folder selected in **Step 3**.
7. Click **Save in**.
8. From the explorer tree, either click the drive or root folder that contains the output files or type in the full folder path in the Folder box, and then click **OK**.
9. From the **File format** box in the Output Folder group, choose the extension that matches the output file-type you are working with (note: the available types displayed will reflect the allowable file translations depending on the selected input file format).
10. If the selected coordinate system parameters specify that the output coordinates are geographic coordinates, then select the appropriate format type from the **Geographic Format** box.
11. If the output file format will be either a formatted text (*.txt) or comma separated values (*.csv) file, click **Write header to dat/csv output files** if you wish to have a standard header printed at the start of every output file.
12. Click **OK**.
If you have selected **Prompt for output zone** in the **Coordinate System** dialog box, or if you are transforming a Queensland Interchange Format file (*.qif) and the coordinates to be printed to the output file are projection coordinates, you will be prompted to specify a zone for each output file. See “4.2 Changing the Coordinate System Parameters” and “4.4.2 Transforming Multiple Files” for more information.

If you have selected **Recurse subfolders**, GDAy will look in every folder contained within the selected input folder for files that match the input file format. If any subfolders are found, GDAy provides you with the option to replicate the entire input folder structure by prompting you to create new output subfolders matching this structure.

Figure 4g shows the dialog that prompts you to create a new output folder.
As shown above, there are five folder-handling options to choose from, with an additional option to access the On-Line Help. Table 4b lists the five optional buttons and their associated action.

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>Create this subfolder only. Show this prompt again when another subfolder is not found</td>
</tr>
<tr>
<td>Yes All</td>
<td>Create any subfolders not found in the output folder</td>
</tr>
<tr>
<td>No</td>
<td>Skip the creation of this subfolder only. Show this prompt again when another subfolder is not found. If this subfolder contains other subfolders, they will be ignored.</td>
</tr>
<tr>
<td>No All</td>
<td>Skip the creation of any subfolders not found in the output folder. If any subfolders found contain other subfolders, they will be ignored also</td>
</tr>
<tr>
<td>Cancel (Esc)</td>
<td>Exit the folder transformation</td>
</tr>
</tbody>
</table>

If a folder could not be created or if you do not have sufficient privileges to create new folders, an error message will be displayed.

After the files have been successfully transformed, you will be prompted to transform another folder. If at least one point in any of the input files could not be transformed, or an error occurred in the file-read/write process, the particular error details and the input coordinates are printed to the Log File.

4.4.4 Supported File Types

GDAy supports Formatted Text files (*.dat, *.prn, *.txt), Comma Separated files (*.csv), Survey Control Database (SCDB) MAN files (*.man), NEWGAN Res files (*.res) and Queensland Interchange Format (QIF) files (*.qif). For the technical specifications on the format of MAN and QIF files, contact Cadastral and Geodetic Data, Department of Natural Resources and Mines, QLD.

It is not recommended that you attempt to create SCDB or QIF files for your input coordinates. The facility to transform SCDB and QIF files is for the purpose of transforming those files issued from the Department of Natural Resources and Mines QLD only.

When transforming formatted text and Comma Separated files, you can specify your input coordinates to be any one of the available types. For files that contain geographic coordinates, you can format the latitude and longitude values using one of five types: Decimal Degrees; DMS HP Notation; Separated DMS Fields, DMIN HP Notation, and; Separated DMIN Fields.

An important note to make is that you cannot have different coordinate types in the input file to be transformed. For example, when you are transforming geographic coordinates, you cannot have latitude and longitude on one record and easting, northing and zone on another. Similarly, if you are transforming a file of geographic coordinates, you must use only one type of format for all values within the file.
Where a different output file type is required to the input file type, GDAy supports the file conversions shown in Table 4c.

**Table 4c – Available File Conversions**

<table>
<thead>
<tr>
<th>Input File Type</th>
<th>Output File Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Formatted Text files (*.dat, *.prn, *.txt)</td>
<td>Comma Separated files (*.csv)</td>
</tr>
<tr>
<td>Comma Separated files (*.csv)</td>
<td>Formatted Text files (*.dat, *.prn, *.txt)</td>
</tr>
<tr>
<td>Survey Control Database (SCDB) files (*.man)</td>
<td>Comma Separated files (*.csv)</td>
</tr>
<tr>
<td>Survey Control Database (SCDB) files (*.man)</td>
<td>Formatted Text files (*.dat, *.prn, *.txt)</td>
</tr>
<tr>
<td>NEWGANG Res files (*.res)</td>
<td>Comma Separated files (*.csv)</td>
</tr>
<tr>
<td>NEWGANG Res files (*.res)</td>
<td>Formatted Text files (*.dat, *.prn, *.txt)</td>
</tr>
</tbody>
</table>

### 4.4.5 Formatting Options for Geographic Coordinates in DAT, TXT, PRN and CSV files

When you want to transform *.dat or *.csv files having geographic coordinates (i.e. latitude and longitudes), you can format your data to one of five types: Decimal Degrees; DMS HP Notation; Separated DMS Fields, DMIN HP Notation, and; Separated DMIN Fields.

**Decimal Degrees**

If you work with decimal degrees values, the Latitude and Longitude fields should each contain only one numeric value. If you are working with *.dat files, the maximum number of significant digits your values can have is 15 significant figures. Since the maximum field width for both latitude and longitude is 16 characters, excluding the decimal point leaves a maximum of 15 characters. For all coordinates used throughout Australia, the number of significant figures for the Latitude field will be reduced to 14 to cater for the negative (minus) sign.

For example, consider the following valid *.dat file records:

```
123456789 123456789 123456789 123456789 123456789 123456789 123456789 12345
STATION A -24.1517849671 149.65465654883 12.120 AGD 1st Order Control
STATION A -24.15178 149.65466 55 1st Order Control
STATION A -24.151784 149.654657 12.12 1st Order Control
STATION A -24.15178496 149.65465654
```

In the above example, all file records are correct since both latitude and longitude values lie within the specified character columns.

If you are working with *.csv files, you do not need to worry about a maximum character width. You only need to be concerned about placing the whole of each value within the commas.
For example, consider the following valid *.csv file records (using the same values as in the preceding example):

```
STATION A,-24.1517849671,149.65465654883,12.120,,AGD,1st Order Control
STATION A,-24.15178,149.65466,,55,,1st Order Control
STATION A,-24.151784,149.654657,12.12,,1st Order Control
, -24.15178496,149.65465694,
```

In the preceding example, all file records are correct since both latitude and longitude values lie within the commas, delineating the start and end of their values.

**Note:** When formatting Decimal Degrees in *.csv files, there must be at least 3 commas for valid input.

**DMS HP Notation**

HP Notation stands for Hewlett Packard Notation and is another well accepted format for degrees minutes and seconds. This form of numeric input requires no additional spaces to delineate the values of degrees, minutes and seconds. All values must be formatted so that the decimal point appears directly after the degrees value, not after units of seconds. For example, a value of -24° 09’ 06.42588” would appear as -24.090642588

When working with DMS HP Notation in *.dat files, the Latitude and Longitude fields should be formatted exactly as they would be for decimal degrees. For example, the maximum number of significant digits your values can have is 15 significant figures. Since the maximum field width for both latitude and longitude is 16 characters, excluding the decimal point leaves a maximum of 15 characters.

For example, consider the following valid *.dat file records:

```
1 2 3 4 5 6 7 8
123456789 123456789 123456789 123456789 123456789 123456789 123456789 12345
STATION A -24.090642588160149.391676357580 12.120 AGD 1st Order Control
STATION A -24.09064 149.39167 55 1st Order Control
STATION A -24.090642 149.391676 12.12 1st Order Control
STATION A -24.09064259 149.39167636
```

In the above example, all file records are correct since both latitude and longitude values lie within the specified character columns.

If you are working with *.csv files, you do not need to worry about a maximum character width. You only need to be concerned about placing the whole of each value within the commas.

For example, consider the following valid *.csv file records (using the same values as in the preceding example):

```
STATION A,-24.1517849671,149.65465654883,12.120,,AGD,1st Order Control
STATION A,-24.15178,149.65466,,55,,1st Order Control
STATION A,-24.151784,149.654657,12.12,,1st Order Control
, -24.15178496,149.65465694,
```
In the above example, all file records are correct since both latitude and longitude values lie within the commas, delineating the start and end of their values.

Note: When formatting DMS HP Notation in *.csv files, there must be at least 3 commas for valid input.

Separated DMS Fields

If you work with Separated DMS fields values, the Latitude and Longitude fields should be formatted with spaces or commas (depending on the file type) between the degrees, minutes and seconds values. The degrees and minutes values should have a precision of zero (like an integer value), whilst the seconds value can have a number of decimal places.

For example, a value of -24° 09’ 06.42588” would appear as:

```
-24 09 06.42588    or    - 24 9 6.42588   in a *.dat file, and
......,-24,09,06.42588,..... or ......,-24,9,6.42588,.....   in a *.csv file.
```

If you are working with *.dat files, the maximum precision your seconds values can have is 10 decimal places. Since the maximum field width for both latitude and longitude is 16 characters, excluding the decimal point, two spaces, and the degrees & minutes values leaves a maximum of 10 characters. For all coordinates used throughout Australia, the maximum number of decimal places for the seconds field will be reduced to 8 to cater for the negative (minus) sign and double digits for the degrees value.

For example, consider the following valid *.dat file records:

```
<table>
<thead>
<tr>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
</tr>
</thead>
<tbody>
<tr>
<td>123456789</td>
<td>123456789</td>
<td>123456789</td>
<td>123456789</td>
<td>123456789</td>
<td>123456789</td>
<td>123456789</td>
<td>123456789</td>
</tr>
<tr>
<td>STATION A</td>
<td>-24 9 06.42588160</td>
<td>149.391676357580</td>
<td>12.120</td>
<td>AGD,1st Order Control</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>STATION A</td>
<td>-24 09 6</td>
<td>149.391676</td>
<td>12.120</td>
<td>55</td>
<td>1st Order Control</td>
<td></td>
<td></td>
</tr>
<tr>
<td>STATION A</td>
<td>-24 9 6.42</td>
<td>149.391676</td>
<td>12.120</td>
<td>1st Order Control</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>STATION A</td>
<td>-24 09 6.4259</td>
<td>149.39167636</td>
<td>12.120</td>
<td>1st Order Control</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

In the above example, all file records are correct since both latitude and longitude values lie within the specified character columns and there exists a space between the degrees, minutes and seconds values. Note that if you work with values to the nearest second, you do not need to enter in a decimal point. If you are working with *.csv files, you do not need to worry about a maximum character width. You only need to be concerned about placing a comma between the degrees, minutes and seconds values.
For example, consider the following valid *.csv file records (using the same values as in the preceding example):

| STATION A, -24.9, 06.4258816, 149, 39, 16.763576, 12.120, AGD, 1st Order Control |
| STATION A, -24.09, 6, 149, 39, 17, 55, 1st Order Control                           |
| STATION A, -24.9, 6.42, 149, 39, 16.76, 12.12, 1st Order Control                |
| STATION A, -24.09, 6.4259, 149, 39, 16.7636,                                   |

In the above example, all file records are correct since both latitude and longitude values lie within the commas, delineating the start and end of each of the sub-values (i.e. degrees, minutes and seconds) that make up the whole value.

**Note:** When formatting Separated DMS Fields in *.csv files, there must be at least 7 commas for valid input.

**DMIN HP Notation**

The formatting requirements for DMIN HP Notation are similar to DMS HP Notation, however the coordinates are formatted to degrees and minutes only. All values must be formatted so that the decimal point appears directly after the degrees value, not after units of minutes.

For example, a value of -24° 9.001071’ would appear as -24.09001071.

Similarly, the output precision specified for DMS HP Notation applies to DMIN HP Notation.

**Separated DMIN Fields**

The formatting requirements for Separated DMIN Fields are similar to Separated DMS Fields, however the coordinates are formatted to degrees and minutes only. If you work with Separated DMIN fields values, the Latitude and Longitude fields should be formatted with spaces or commas (depending on the file type) between the degrees and minutes values.

The degrees value should have a precision of zero (like an integer value), whilst the minutes value can have a number of decimal places.

For example, a value of -24° 9.001071” would appear as:

-24 09.001071 or - 24 9.001071 in a *.dat file, and

......,-24,09.001071,...... or ......,−24,9.001071, ... in a *.csv file.
5 UNDERSTANDING GDAy OUTPUT FILES

5.1 Interactive Output File

Each time you press Compute on the main GDAy dialog, your coordinates are printed to the interactive output file in a structured way so that you may use the file when opening it in another application, such as MapInfo, Arc-Info or Microsoft Excel. Each time you start GDAy, the Default file name for the interactive output is used to create a new file, or if the file exists, clear the file’s contents ready for writing. The filename is displayed in the status bar on the bottom of the main GDAy dialog.

Every record (or line) in the interactive output file contains data fields in particular file positions (or columns). Depending on what coordinate system parameters, point numbering and station naming options you have selected, certain fields may be present whilst others may not.

Table 5a description of the fields printed in order:

<table>
<thead>
<tr>
<th>Field</th>
<th>Columns</th>
<th>Characters</th>
<th>Printed?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Point No</td>
<td>1 – 10</td>
<td>10</td>
<td>Optional</td>
</tr>
<tr>
<td>Input Lat / East</td>
<td>11 - 27</td>
<td>17</td>
<td>Always</td>
</tr>
<tr>
<td>Input Long / North</td>
<td>28 – 44</td>
<td>17</td>
<td>Always</td>
</tr>
<tr>
<td>Datum (AGD or G94)</td>
<td>45 – 53</td>
<td>9</td>
<td>Always</td>
</tr>
<tr>
<td>Output Lat / East</td>
<td>54 – 70</td>
<td>17</td>
<td>Always</td>
</tr>
<tr>
<td>Output Long / North</td>
<td>71 – 87</td>
<td>17</td>
<td>Always</td>
</tr>
<tr>
<td>Datum (AGD or G94)</td>
<td>88 – 96</td>
<td>9</td>
<td>Always</td>
</tr>
<tr>
<td>UTM Zone</td>
<td>97 – 101</td>
<td>5</td>
<td>Only when output coordinates are projected</td>
</tr>
<tr>
<td>Station Name</td>
<td>102 – 127</td>
<td>26</td>
<td>Optional</td>
</tr>
<tr>
<td>Latitude Accuracy</td>
<td>128 – 134</td>
<td>7</td>
<td>Only when accuracy can be interpolated</td>
</tr>
<tr>
<td>Longitude Accuracy</td>
<td>135 - 141</td>
<td>7</td>
<td>Only when accuracy can be interpolated</td>
</tr>
</tbody>
</table>

The following is an example of an Interactive Output file (omitting the header).

<table>
<thead>
<tr>
<th>Point No</th>
<th>Input Lat / East</th>
<th>Long / North</th>
<th>Datum</th>
<th>Output Lat / East</th>
<th>Long / North</th>
<th>Datum Zone</th>
<th>Station Name</th>
<th>Accuracy</th>
</tr>
</thead>
<tbody>
<tr>
<td>105441</td>
<td>-27 32 05.41000</td>
<td>153 03 54.65120 AGD</td>
<td>506436.083</td>
<td>6954312.245 AGD</td>
<td>56 Projection Coordinates</td>
<td>56</td>
<td>153 03 54.65120 AGD</td>
<td>56</td>
</tr>
<tr>
<td>105442</td>
<td>-27 32 05.41000</td>
<td>153 03 54.65120 AGD</td>
<td>506436.083</td>
<td>6954312.245 AGD</td>
<td>56 Separated DMS fields</td>
<td>56</td>
<td>153 03 54.65120 AGD</td>
<td>56</td>
</tr>
<tr>
<td>105443</td>
<td>-27 32 05.41000</td>
<td>153 03 54.65120 AGD</td>
<td>506436.083</td>
<td>6954312.245 AGD</td>
<td>56 Decimal degrees</td>
<td>56</td>
<td>153 03 54.65120 AGD</td>
<td>56</td>
</tr>
</tbody>
</table>

By default, all geographic coordinates are printed using a precision of 5 decimal places for seconds, 7 decimal places for decimal minutes, and 9 decimal places for decimal degrees. When you are working...
with projection coordinates, the coordinates are printed using a precision of 3 decimal places for metres. This cannot be changed.

5.1.1 Create a New Output File

To create a new interactive output file

1. On the File menu, point to Interactive Input and then click the New Output File from the pop-up menu.
2. In the Save in box, click the drive or folder that you want to save the file in.
3. In the Save as type box, note that the only predefined file-type is GDAy Output Files (*.out).
4. In the folder list, double-click folders until you open the folder that contains the file. To create a new folder, click the Create New Folder icon and then type a name for the new folder in the Name box.
5. In the file name box, type in the name of the file you want to save as the default interactive output file.
6. Click OK.

Note that when you click OK, the new output file is displayed in the status bar on the bottom of the main GDAy dialog. If you have selected an existing file, its contents are deleted ready for writing. If you create a new output file, the Default file name will not be changed. The next time you start GDAy, the Default Output file is opened and the new file you created is kept.

If the data printed to the interactive output file is important to you, select the Create new file at start up. With this option selected, you will be prompted with the File Save As dialog box to create a new interactive output file. The Default file name will be kept, and the file’s contents will be retained.

You can create a new interactive output file at any time when using GDAy.

5.1.2 Viewing and Printing the Output File

To view the interactive output file

1. On the File menu, point to Interactive Input and then click View Output File.

This will display the current interactive output file in Microsoft Notepad. To print the Output file, select Print from the File menu in Notepad.
5.2 GDAy Log File

When you start GDAy, the header is printed to the Log file. The default distortion grid and transformation parameters are printed also. Each time an error occurs, the error message and the coordinates (or file record) are printed to the log file.

Below is the default header information from an example log file.

```
/////       GDAy Transformation Log File /////
Created: Sunday, 23 June 2002, 12:54:21 PM.
Version 2.1 © 2002 Natural Resources and Mines, QLD.
Distortion Grid: D:\GDA\Grids\National 84 (02.07.01).gsb (Canadian NTv2 Binary)
Transformation Parameters: AGD84 - GDA94 (National)
```

Below is some typical information written to the log file when an error occurs.

```
The point lies outside the extents of the distortion grid:
D:\GDA\Grids\National 84 (02.07.01).gsb
>> S 0° E 0°
Beginning points file transformation...
Input file: C:\Data\AGD84 SepGDAy.dat
Output file: C:\Data\GDA SepGDAy.dat

The point lies outside the extents of the distortion grid:
D:\GDA\Grids\National 84 (02.07.01).gsb
>> Zone Bound -07 30 00.01650 150 00 00.01607   10.000 55  AGD PM 1001 GPS Class A
>> 23 points were transformed. End of points file transformation.

Beginning points file transformation...
Input file: C:\Data\GDA94 UTM GDAy.dat
Output file: C:\Data\GDA SepGDAy.dat

The following record does not contain valid numeric input:
>> Created: Sunday, 22 August 1999.

The required data could not be extracted from the following record:
>> Photo Ctrl 500000.5575 12931067.2381 10931067.2381 56

The required data could not be extracted from the following record:
>> Photo 1 319640.223 6807404.240 10.000 56 G94 PM 1001 GPS Class A

The required data could not be extracted from the following record:
>> Photo 2 399433.344 6782026.177 10.000 56 G94 PM 1001 GPS Class A

>> 0 points were transformed. End of points file transformation.
```

The first block of data is the error message displayed after an attempt was made to perform an Interactive transformation using 0° latitude and 0° longitude.
The next block of information relates to a Points File transformation. When the file transformation begins, the input and output files are logged. Any errors that occur (such as point being outside the limits of the distortion grid) are logged also. At the end of the file transformation, the number of successfully transformed points is logged. The next block of information is an example of selecting an input file in projection coordinates, whilst the Coordinate System parameters for Input Coordinates have been set for geographic coordinates.

5.2.1 Viewing and Printing the Log File

To view the log file

1. On the Tools menu, click View Log File.

This will display the default Log file in Microsoft Notepad. To print the Log file, select Print from the File menu in Notepad.
6 CUSTOMISING GDAy

You can customise the main GDAy dialog and the way in which GDAy handles your interactive output file and log files. To open the Options dialog, click Options on the Tools menu.

6.1 GDAy View Options

Figure 6a shows the View tab of the Options dialog.

Point Numbering

In the Show group, you can control how you manage the numbering of unique identifiers for your coordinates. If you select the Point numbering check box, the Station No edit box on the main GDAy dialog appears. Each time you press Compute, you will be directed to this edit box to enter in a new station number.

If you are working with points that are arranged in numeric order, click on the Auto increment check box. In the Start at edit box, you can specify a starting number from which all subsequent point numbers will be incremented. Whenever you press Compute, your point numbers are automatically incremented. Each time GDAy starts in this mode, the number in the Start at edit box will be displayed in the Point numbering edit box on the main GDAy dialog.

Figure 6a – The View Tab

Auto Format
In the **Auto format** group, you can control the appearance of the input and output coordinate values. If you select the **Latitudes as “positive south”** check box, you may enter in latitudes as positive values and GDAy will recognise them as being in the Southern Hemisphere. This saves you having to enter in a minus sign each time you want to use negative latitudes. This option applies only to entering in latitudes through the main GDAy dialog. For example, you must still use negative values for latitudes when transforming a file of geographic coordinates. The transformed coordinates that appear in the edit boxes on the right will still display negative values for latitudes south of the equator regardless of the status of the **Latitudes as “positive south”** check box.

If you select the **Geographic values with “N/S” and “E/W”** check box, each time you enter in a value in the **Input coordinates** edit boxes in the main GDAy dialog and then press the Tab key, the coordinates are formatted to reflect the position of the point in relation to the equator and Greenwich meridian. For example, if –27.24373345 is entered in for latitude and 153.57386347 is entered in for longitude, when you press the Tab key the edit boxes will show S 27.24373345 and E 153.57386347 respectively. This option only applies when you are entering in geographic coordinates.

If you select the **Degrees minutes and seconds values with symbols** check box, each time you enter in geographic coordinates in the **Input coordinates** edit boxes in the main GDAy dialog and then press the Tab key, the values are formatted to reflect the symbols for degrees minutes and seconds. For example, if –27.24373345 is entered in for latitude and 153.57386347 is entered in for longitude, when you press the Tab key the edit boxes will show … 27° 24’ 37.3345” and … 153° 57’ 38.6347” respectively. Similarly, values in degrees and minutes will be formatted the same. This option only applies when you are entering in geographic coordinates.

### Output Coordinates Precision

In the **Working precision** group, you can control the number of decimal places for the output coordinates. The default precision for seconds and decimal minutes is 5 decimal places, whilst the default for metres is 3 decimal places. Where the output coordinates are in decimal degrees, the displayed precision will be the number of decimal places for seconds plus 4.

For example, if you have set the value in the **Seconds** edit box to 6, Table 6a shows the format of data that will be displayed in the output edit boxes each time you press **Compute**.

<table>
<thead>
<tr>
<th>Format Type</th>
<th>Output edit box display</th>
</tr>
</thead>
<tbody>
<tr>
<td>Degrees, minutes and seconds (auto formatted with symbols)</td>
<td>27° 00’ 02.012500”</td>
</tr>
<tr>
<td>Degrees and minutes (auto formatted with symbols)</td>
<td>27° 00.033542”</td>
</tr>
<tr>
<td>Degrees, minutes and seconds (without symbols)</td>
<td>27.0002012500</td>
</tr>
<tr>
<td>Degrees and minutes (without symbols)</td>
<td>27.00033542</td>
</tr>
<tr>
<td>Decimal degrees</td>
<td>27.0005590278</td>
</tr>
</tbody>
</table>
6.2 Interactive Output File Options

Figure 6b shows the Interactive Output tab of the Options dialog.

Default Interactive Output File Location

Each time you start GDAy, the Default file name for the interactive output is used to create a new file, or if the file exists, clear the file’s contents ready for writing.

To change the Default file name for the interactive output file

1. In the File settings group, click Change.
2. In the Save in box, click the drive or folder that you want to save the file in.
3. In the Save as type box, note that the only predefined file-type is GDAy Output Files (*.out).
4. In the folder list, double-click folders until you open the folder that contains the file. To create a new folder, click the Create New Folder icon and then type a name for the new folder in the Name box.
5. In the file name box, type in the name of the file you want to save as the default interactive output file. Otherwise, select an existing *.out file from the list to be overwritten the next time you start GDAy.
6. Click OK.

Figure 6b – Interactive Output Tab

If you change the Default file name and then click OK to accept the Interactive Output options, the output file name will be displayed in the status bar on the bottom of the main GDAy dialog. The next time you start GDAy the default file name will be used to create a new interactive output file. If the data printed to the interactive output file is important to you, select the Create new file at start up.
With this option selected, you will be prompted with the **File Save As** dialog box to create a new interactive output file each time GDAy is run. In this case, the **Default file name** will be kept, and the file's contents will be retained.

**Station Naming**

To provide a short description for your coordinates, you can include **Station naming**. Each time you press **Compute** on the main GDAy dialog, this short description can be printed to the interactive output file with your coordinates. To include **Station naming**, in the **Station Naming** group, select the **Add station names** check box.

You now have two options available to you: **Prompt for station name** and **Auto naming**. If you select the **Prompt for station name** radio button, each time you press **Compute** on the main GDAy dialog you will be prompted to enter a station name or description (maximum of 25 characters) to be added to the interactive output file.

If you select the **Auto naming** radio button, the **Default station name** edit box will appear. If the **Auto naming** radio button is selected, the information contained in the edit box will be automatically added to the interactive output file each time you press **Compute** on the main GDAy dialog.

### 6.3 Log File Options

Figure 6c shows the **Log File** tab of the Options dialog.

**Default Log File Location**

Each time you start GDAy, the **Default file name** for the log file is used to create a new file, or if the file exists, clear the file's contents ready for logging. The purpose of this log file is to document particular items pertinent to user operation and individual coordinate transformations. For example, the input and output coordinate system parameters and the distortion grid file are logged by default each time you start GDAy.
Each time you press **Compute** on the main GDAy dialog, any errors that occurred (such as a point being outside the limits of the selected distortion grid file) are logged using the input coordinates and a short message. Whenever you perform a points file transformation the input and output file names are logged. If there are any errors that occurred (such as a point being outside the limits of the selected distortion grid file, or when the coordinates cannot be read from the file) are logged using the input coordinates and a short message.

To change the **Default file name** for the log file

1. Click **Change** from the **File settings** group.
2. In the **Save in** box, click the drive or folder that you want to save the file in.
3. In the **Save as type** box, note that the only predefined file-type is **GDAy Log Files** (*.log).*
4. In the folder list, double-click folders until you open the folder that contains the file. To create a new folder, click the **Create New Folder** icon and then type a name for the new folder in the **Name box**.
5. In the **file name** box, type in the name of the file you want to save as the default log file. Otherwise, select an existing *.log file from the list to be overwritten the next time you start GDAy.
6. Click **OK**.

If you change the **Default file name** and then click **OK** to accept the **Log File** options, a new log file is created and information is printed to it immediately.
Log File Header

To personalise the log file created when using GDAy, you can add a header of information to the log file by adding text to the Add header to log file text box. Each time you start GDAy, or choose a new Default file name, the text displayed in this box is printed at the start of the file.

To change the information that is printed to the log file, add the information relevant to your needs. Wherever you type in << Date >> (exactly, with only one space either side of the word “Date”), the full system date at the time of creating the file will be printed to the log file. For example, if the message shown in figure 6d is accepted with OK, the next time you start GDAy the log file will contain information as shown in Figure 6d.

Note that the text may not appear exactly in the log file as it does in the text box since the fonts below may differ to the system font used to display information on your computer.

Figure 6d – Sample Log File

```
GDAy Transformation Log File

Created: Friday, 19 May 2002, 01:12:13 PM.

Version 2.1   (c) Department of Natural Resources and Mines, QLD.

Distortion Grid:  D:\GDA\Grds\QLD_0900.gsb (Canadian NTv2 Binary)

Transformation Parameters:  National AGD84 – GDA94
```
7 ERROR RETURN MESSAGES

When you attempt to transform coordinates and an error occurs, GDAy tracks the error and dispatches an error message to detail what has happened. Since you may perform Interactive transformations (on the main GDAy dialog) and Points File transformations, there are two ways in which an error message can be displayed. These are by a simple Yes / No Message Box and/or by printing to the Log file.

7.1 Distortion Grid File Errors

The following message is displayed when the distortion grid cannot be found or opened.

"GDAy could not read from the specified distortion grid file: [file location]\ [filename]"

The following message is displayed when any file type other than *.asc or *.gsb is selected.

"*. [filetype]
GDAy cannot read this type of grid file."

The following message is displayed if the selected grid file contains an error or does not conform to the NTv2 format.

"GDAy found an error in the specified distortion grid file: [file location]\ [filename]"

The following messages are displayed if the required coordinate shifts could not be retrieved from the selected distortion grid file. It will be possible that the grid file contains an error or does not conform to the NTv2 format.

"GDAy could not obtain the interpolation shifts from the required file offset in the [filetype] file: "

The following message is displayed if the point being transformed lies outside the extents of the distortion grid.

"The point lies outside the extents of the distortion grid."

"The point lies outside the extents of the distortion grid."
With all distortion grid error messages that are prompted to the user after an interactive transformation, the following message is appended.

"Do you wish to continue with a 7 Parameter Transformation only using the [Selected parameters] parameters? "

If YES is selected, a 7-Parameter transformation is performed using the transformation parameters you selected from the Select Distortion Grid dialog box as described in "4.1 Selecting a Distortion Grid".

7.2 File Transformation Errors

The following message is displayed if the input file does not exist or cannot be opened.

"GDAy could not read from the specified input file: [filename]
File transformation aborted."

The following message is displayed if the output file cannot be opened for writing.

"GDAy could not write to the specified output file: [filename]
File transformation aborted."

The following message is displayed if GDAy does not support the selected input file type. The only supported file types are *.dat, *.prn, *.txt, *.csv, *.man, *.res and *.qif.

"*. [filetype] GDAy cannot read coordinate files of this type.
File transformation aborted."

The following message is displayed if GDAy does not support the selected output file type. The only supported file types are *.dat, *.prn, *.txt, *.csv, *.man, *.res and *.qif.

"*. [filetype] GDAy cannot produce coordinate files of this type.
File transformation aborted."

The following message is printed to the log file if the coordinates could not be extracted from the input file. This can occur where the data fields in a Formatted Text file are incorrectly positioned, or the coordinate system parameters do not match the format of the input file.
"GDAy could not extract the required data from the input file: "

The following message is printed to the log file if the point being transformed lies outside the extents of the distortion grid.

"A point lies outside the extents of the distortion grid: "

The following message is displayed if the Coordinate System parameters set in GDAy do not match the format of the specified QIF file.

"The GDAy coordinate system parameters do not match the format of the specified QIF file: [filename]
File transformation aborted."

The following message is displayed if the coordinate type could not be determined from the QIF file. It will be possible that the QIF file has been corrupted or does not conform to the Department of Natural Resources and Mines QIF specifications.

"The coordinate system parameters cannot be determined from the specified QIF file: [filename]
File transformation aborted."

When using GDAy to transform files, you may output the coordinates in another file format depending on the type of input and output files. When you are creating an output file that has a different file type to that of the input file, where the input and output file types contain significantly different information, the following message is displayed.

"A *. [filetype] cannot be created from a *. [filetype]."
8 WORKING WITH NTv2 DISTORTION GRIDS

8.1 View the Default Distortion Grid’s Properties

To view the default distortion grid’s properties, point to Distortion Grid Settings from the File menu and then select Grid Properties…. This will display the Distortion Grid Properties dialog box as shown in Figure 8a. From the Distortion Grid Properties dialog box, you can view particular information relating to the file type, version and geometric properties of the default distortion grid.

Figure 8a – The Distortion Grid Properties Dialog Box

Table 8a summarises the information displayed in the Distortion Grid Properties dialog box.

Table 8a – Grid Parameters Dialog Information

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Name</td>
<td>The full file path</td>
</tr>
<tr>
<td>File Type</td>
<td>ASCII or Binary. (Note. “Binary (Australian)” will be shown if you have selected the distortion grid that was initially released for your jurisdiction. See Appendix B.3 Necessary Considerations for NTv2 Usage for more information on Australian and Canadian NTv2 Binary file formats.</td>
</tr>
<tr>
<td>Version</td>
<td>The file version for the Queensland distortion grid QLD_0900.gsb is “QLD_0900”. The version of the initial release of the Queensland grid is “GG_2.42”. The reason for adopting the new version is explained in Appendix B.3.1 Difference Between Australian and Canadian Binary Files.</td>
</tr>
<tr>
<td>No. Sub-Grids</td>
<td>A distortion grid may contain several sub grids of different densities. The limits of these sub grids will all be contained within the parent grid. If there is only one sub grid, then it is the parent grid. See Appendix B.1 Grid Shift File Concept for more information.</td>
</tr>
</tbody>
</table>
Sub-Grid Name | This drop-down box shows all sub-grids within the parent grid. Depending on the number of sub grids, you may view the limits for each sub grid. The North, South, East and West limits will be displayed for the selected sub grid name.

Reference Systems | The reference systems for which the distortion grid supports coordinate transformations from and to. For example, the reference system for the Geocentric Datum of Australia (GDA) is the Global Reference System of 1980 (GRS80).

8.2 Export the Default Distortion Grid File

To export the default distortion grid file to another format

1. On the File menu, point to Distortion Grid Settings and then Export Grid File.
2. Depending on the file type of the currently selected distortion grid, select either to ASCII or to Binary.
3. In the Save in box, click the drive or folder that you want to save the new distortion grid file in.
4. In the folder list, double-click folders until you open the folder that you want to save the new distortion grid file in.
5. Specify a file name. By default, GDAy enters the new file name in the file name box. You may change this if you do not want to overwrite an existing file.
6. Click OK.

You may export an ASCII grid file to Binary format by performing the above steps once you have chosen an ASCII grid file. In this case, the Binary file produced will be in the Canadian NTv2 format. See “Appendix B.3 Necessary Considerations for NTv2 Usage” for more information on Australian and Canadian NTv2 Binary file formats.

8.3 Extract part of a Grid with Grid Extractor

To extract part of a grid using coordinates that define an area or location

1. On the File menu, point to Distortion Grid Settings and then Run Grid Extractor.
2. Click Browse to select the grid file you wish to extract the grid shift data from.
3. Click Save As to specify a new grid file name.
4. Select N, S, E, W Limits to enter in coordinates that delimit the extents of known area, or select Location and Radius to specify a central location and distance for a region surrounding the area you desire.
5. Click Extract.

Once the grid file has been created, you will be prompted to view the log file.
APPENDIX A – DAT, TXT, PRN and CSV FILE FORMAT SPECIFICATION

A.1 Formatted Text Files (*.dat, *.txt, *.prn)

Every record (or line) in a formatted text file must contain data fields in particular file positions (or columns). You may however, omit certain fields depending on what they are. Table A1 lists the compulsory and non-compulsory fields in the required order:

<table>
<thead>
<tr>
<th>Field</th>
<th>Columns</th>
<th>Characters</th>
<th>Compulsory?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Point ID</td>
<td>1 – 11</td>
<td>11</td>
<td>No</td>
</tr>
<tr>
<td>Latitude / Easing</td>
<td>12 – 27</td>
<td>16</td>
<td>Yes</td>
</tr>
<tr>
<td>Longitude / Northing</td>
<td>28 – 43</td>
<td>16</td>
<td>Yes</td>
</tr>
<tr>
<td>Orthometric Height (AHD)</td>
<td>44 – 52</td>
<td>9</td>
<td>No</td>
</tr>
<tr>
<td>UTM Zone</td>
<td>53 – 55</td>
<td>3</td>
<td>Compulsory when output coordinates are projected. Optional for geographic coordinates.</td>
</tr>
<tr>
<td>Datum (AGD or G94)</td>
<td>56 – 59</td>
<td>4</td>
<td>No</td>
</tr>
<tr>
<td>Description</td>
<td>60 – 85</td>
<td>26</td>
<td>No</td>
</tr>
</tbody>
</table>

Note that the UTM zone is only required when you are transforming a file of projection coordinates.

File position (column no’s):

```
1  2  3  4  5  6  7  8  
123456789 123456789 123456789 123456789 123456789 123456789 123456789 123456789 
```

Decimal Degrees:

```
69540299  -27.876576516  153.132465498  765.010  AGD PSM 6954 Feb 1999
-26.926733461  149.654651687  55  1st Order Control 
```

DMS HP Notation:

```
69540299  -27.523567546  153.075687579 
STATION B  -26.553624046  149.391674607  1st Order Control 
```

Separated DMS Fields:

```
69540299  -27  52  35.67546  153  07  56.87579  765.010  AGD
STATION B  -26  55  36.24046  149  39  16.74607  1st Order Control 
```

DMIN HP Notation:
69540299  -27.525945910  153.079479298
  -26.556040077  149.392791012  1st Order Control

Separated DMIN Fields:
69540299  -27.525945910  153.079479298  765.010  AGD
STATION B  -26.556040077  149.392791012  1st Order Control

Projection Coordinates
69540299  513039.205  6916452.137  765.010  PSM 6954 Feb 1999
STATION B  763609.224  7018902.575  55  1st Order Control

A.2 Comma Separated Files (*.csv)
Every record (or line) in a comma separated file must contain data fields separated by commas. You may however, omit certain fields depending on what they are. If you choose not to enter in the non-compulsory fields, you must still enter in the commas to delineate the presence of the particular field. Below is a description of the compulsory and non-compulsory fields in the required order:

Table A2 - CSV File Compulsory Items

<table>
<thead>
<tr>
<th>Field</th>
<th>Compulsory?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Point ID</td>
<td>No</td>
</tr>
<tr>
<td>Latitude / Easing</td>
<td>Yes</td>
</tr>
<tr>
<td>Longitude / Northing</td>
<td>Yes</td>
</tr>
<tr>
<td>Orthometric Height (AHD)</td>
<td>No</td>
</tr>
<tr>
<td>UTM Zone</td>
<td>Compulsory when output coordinates are projected. Optional for geographic coordinates.</td>
</tr>
<tr>
<td>Datum (AGD or G94)</td>
<td>No</td>
</tr>
<tr>
<td>Description</td>
<td>No</td>
</tr>
</tbody>
</table>

Note that the UTM zone is only required when you are transforming a file of projection coordinates.

Decimal Degrees:

DMS HP Notation:
69540299, -27.523567546,153.075687579,,,
STATION B, -26.553624046,149.391674607,,1st Order Control
Separated DMS Fields:
, -27, 52, 35.67546, 153, 07, 56.87579, 765.010,,AGD, STATION B,-26,55,36.24046,149,39,16.74607

Note that when you are entering in geographic coordinates in separated DMS fields, you must include a comma to separate the degrees, minutes and seconds values.

DMIN HP Notation:
69540299,-27.5259945910,153.079479298,,,,, STATION B,-26.5560040077,149.392791012,,,,1st Order Control

Separated DMIN Fields:
, - 27, .52.5945910,153,079479298,765.010,,AGD, STATION B,-26,55.6040077,149,39.2791012,,,,1st Order Control

Note that when you are entering in geographic coordinates in separated DMIN fields, you must include a comma to separate the degrees and minutes values.

Projection Coordinates
69540299,513039.205,6916452.137,765.010,56,AGD,PSM 6954 Feb 1999 STATION B,763609.224,7018902.575,,55,,1st Order Control

Note that when a certain data field is not required, you must still enter in the commas to delineate the presence of the field.

The simplest way to create a comma separated file is to use Microsoft Excel. Alternatively, open one of the sample files included in the installation and save it as a new file. Using a text editor, such as Notepad or UltraEdit, add your data to this file using the same format.

To create a CSV file in Excel
1. Create a new spreadsheet
2. Enter in a unique identifier for each new point in Column A.
3. Enter in values for latitude and longitude in Columns B and C, or Easting Northing and Zone in Columns B, C and E.
4. Click Save As from the File Menu
5. In the Save As type box, click CSV (Comma delimited) (*.csv).
6. Click Save.
As an example, Figure A1 shows two records for a CSV file (to be created) in decimal degrees.

Figure A1 – Using Excel to create a CSV file in Decimal Degrees.
APPENDIX B – NTv2 GRID SHIFT FILE FORMAT

The Grid Shift file used by GDAy contains coordinate shift values at nominated grid nodes in a format known as NTv2 (National Transformation Version 2). This format was developed by the Geodetic Survey Division of Geomatics Canada to implement the transformation of coordinates between NAD27 and NAD83 in Canada. Australia recognised the advantages of this format and decided to adopt NTv2 as a standard format.

The following sections describe the Specifications of the NTv2 file format and the considerations for its usage in Australia.

B.1 NTv2 Grid Shift File Concept

The NTv2 grid format is a structured rectangular region of evenly spaced rows of latitude and columns of longitude. The intersection of a row and column is referred to as a grid node. Each node consists of a shift value for both latitude and longitude, as well as a value for the accuracy of each shift as determined in the least squares modelling process.

To provide for a structured means of extracting the values at each node from a digital file, the nodes are consecutively indexed in rows and columns starting at the south east (lower right) corner, finishing at the north west (upper left) corner. The fundamental concept of the grid and node index structure is shown in figure B1.

Figure B1 – Grid Node Order
In its simplest form, as shown by Figure B2, the grid shift file contains a single “sub grid” bound by unique values for each of the following: lower latitude, upper latitude, lower longitude, and upper longitude. The size of the file is directly related to the area it covers and is therefore governed by the number of nodes (file records) contained within the file. The order of these nodes within the file is critical and must be adhered to for accurate grid interpolation.

The ordered grid-node structure within the file allows for direct computation of the location of the file records containing the interpolated shifts. Since, the size of the file is independent of the retrieval method the data retrieval is almost instantaneous. All information required to compute the position of each node within the file is contained within a block of header information at the beginning of the file. The structure and format of NTv2 grid shift file header information is explained in section B2.

**Figure B2 – Grid Shift file with a single sub grid**

<table>
<thead>
<tr>
<th>Grid Shift File Overview</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sub Grid 1 Overview</td>
</tr>
<tr>
<td>Sub Grid 1 Node Values</td>
</tr>
</tbody>
</table>

**Figure B3 – Grid Shift file with multiple sub grids**

<table>
<thead>
<tr>
<th>Grid Shift File Overview</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sub Grid 1 Overview</td>
</tr>
<tr>
<td>Sub Grid 1 Node Values</td>
</tr>
<tr>
<td>Sub Grid 2 Overview</td>
</tr>
<tr>
<td>Sub Grid 2 Node Values</td>
</tr>
</tbody>
</table>

The grid shift file may also contain many sub-grids (Figure B3) of greater densities that cover designated areas within the parent grid area. Figure B4 illustrates the concept of densified sub-grids within a parent grid. In these instances, the grid shift file contains an extra block of header information for each densified sub grid, which are each followed by the interpolated shifts for the nodes within the sub grid.
The order of these sub grids with in the file is of no importance, since the method of retrieval of data from the file follows a logical method based on the concept of a simple hierarchical tree. For example, each time the grid shift file is opened an index (or array) of sub-grids and their parent grid is built and stored in memory.

To conform to the NTv2 format, a set of rules must be followed when combining two or more grid areas within the one file. These rules ensure that a unique sub grid is selected for subsequent interpolation. For more information on the rules regarding the NTv2 format, see “NTv2 Developer’s Guide” (Junkins and Farley, 1995).

B.2 NTv2 File Format

An NTv2 Grid Shift file can be written as an ASCII or binary file. The binary format described in the NTv2 Developer’s Guide (Junkins and Farley, 1995) gives the impression of being FORTRAN specific but it is actually a pure byte dump. The NTv2 Developer’s Guide (Junkins and Farley, 1995) does not specify whether the format of a binary is Little or Big Endian. In Australia all NTv2 binary grid shift files will be distributed as Little Endian binary files.

The following sections describe the format of each component of a Grid Shift file. In describing the format, the data types used are given in Table B1 along with the byte size required for each type. This table relates to a binary Grid Shift file, the format of fields in an ASCII version will vary so they are specified in the Format columns of Tables B.2 to B.4. If an identifier is specified, both the Identifier and Value are written to file otherwise only the Value is written. An Identifier is written to the Grid Shift file as a string. The important thing to note here concerns how integer values are dealt with in a binary file. Each header record must be 16 bytes long so to make a record containing an integer value be 16 bytes, 4 bytes of padding are inserted. The padding used is 4 NULL characters (ASCII character 0).
### Table B1 – Grid Shift File Data Types

<table>
<thead>
<tr>
<th>Type</th>
<th>Bytes</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Integer</td>
<td>4</td>
<td>Followed by 4 NULL characters of padding in binary version of file, i.e. 8 bytes in total</td>
</tr>
<tr>
<td>Float</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>Double</td>
<td>8</td>
<td></td>
</tr>
<tr>
<td>String</td>
<td>8</td>
<td>8 characters</td>
</tr>
</tbody>
</table>

### B.2.1 Grid Shift File Overview

Table B2 specifies the format of the Overview section of a Grid Shift file and a sample is given in Figure B5. This section contains eleven records which give general information about the sub grids within the file. The **NUM_FILE** record is the most useful as it specifies how many sub grids the Grid Shift file contains.

### Table B2 – Grid Shift File Overview Information

<table>
<thead>
<tr>
<th>Record</th>
<th>Identifier</th>
<th>Value</th>
<th>Description</th>
<th>ASCII format</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>NUM_OREC</td>
<td>Integer</td>
<td># header records in overview</td>
<td>%8s%3d</td>
</tr>
<tr>
<td>2</td>
<td>NUM_SREC</td>
<td>Integer</td>
<td># header records in sub grid</td>
<td>%8s%3d</td>
</tr>
<tr>
<td>3</td>
<td>NUM_FILE</td>
<td>Integer</td>
<td># of sub grids</td>
<td>%8s%3d</td>
</tr>
<tr>
<td>4</td>
<td>GS_TYPE</td>
<td>String</td>
<td>Shift type (SECONDS)</td>
<td>%8s%-8s</td>
</tr>
<tr>
<td>5</td>
<td>VERSION</td>
<td>String</td>
<td>Distortion model</td>
<td>%8s%-8s</td>
</tr>
<tr>
<td>6</td>
<td>SYSTEM_F</td>
<td>String</td>
<td>&quot;From&quot; ellipsoid name</td>
<td>%8s%-8s</td>
</tr>
<tr>
<td>7</td>
<td>SYSTEM_T</td>
<td>String</td>
<td>&quot;To&quot; ellipsoid name</td>
<td>%8s%-8s</td>
</tr>
<tr>
<td>8</td>
<td>MAJOR_F</td>
<td>Double</td>
<td>&quot;From&quot; semi major axis</td>
<td>%8s%12.3f</td>
</tr>
<tr>
<td>9</td>
<td>MINOR_F</td>
<td>Double</td>
<td>&quot;From&quot; semi minor axis</td>
<td>%8s%12.3f</td>
</tr>
<tr>
<td>10</td>
<td>MAJOR_T</td>
<td>Double</td>
<td>&quot;To&quot; semi major axis</td>
<td>%8s%12.3f</td>
</tr>
<tr>
<td>11</td>
<td>MINOR_T</td>
<td>Double</td>
<td>&quot;To&quot; semi minor axis</td>
<td>%8s%12.3f</td>
</tr>
</tbody>
</table>

**Figure B5 – Sample Grid Shift File Overview**

```
NUM_OREC 11
NUM_SREC 11
NUM_FILE 1
GS_TYPE SECONDS
VERSION MAY98V20
SYSTEM_FANS
SYSTEM_TGRS80
MAJOR_F 6397160.000
MINOR_F 6396774.719
MAJOR_T 6397137.000
MINOR_T 6396752.314
```
B.2.2 Sub Grid Format

A sub grid consists of a Sub Grid Overview section followed by the values of the nodes in the sub grid. The Overview section specifies the sub grid extents, the grid spacing, the name of the sub grid and the name of the parent sub grid if there was one. A sub grid will have a parent if its extents fall within another sub grid. The format of the Sub Grid Overview is given in Table B3 and a sample is given in Figure B6.

Table B3 – Sub Grid Overview Information

<table>
<thead>
<tr>
<th>Record</th>
<th>Identifier</th>
<th>Value</th>
<th>Description</th>
<th>ASCII format</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>SUB_NAME</td>
<td>String</td>
<td>Sub grid name</td>
<td>%8s%-8s</td>
</tr>
<tr>
<td>2</td>
<td>PARENT</td>
<td>String</td>
<td>Parent sub grid name</td>
<td>%8s%-8s</td>
</tr>
<tr>
<td>3</td>
<td>CREATED</td>
<td>String</td>
<td>Date</td>
<td>%8s%-8s</td>
</tr>
<tr>
<td>4</td>
<td>UPDATED</td>
<td>String</td>
<td>Date</td>
<td>%8s%-8s</td>
</tr>
<tr>
<td>5</td>
<td>S_LAT</td>
<td>Double</td>
<td>Lower latitude</td>
<td>%8s%15.6f</td>
</tr>
<tr>
<td>6</td>
<td>N_LAT</td>
<td>Double</td>
<td>Upper latitude</td>
<td>%8s%15.6f</td>
</tr>
<tr>
<td>7</td>
<td>E_LONG</td>
<td>Double</td>
<td>Lower longitude</td>
<td>%8s%15.6f</td>
</tr>
<tr>
<td>8</td>
<td>W_LONG</td>
<td>Double</td>
<td>Upper longitude</td>
<td>%8s%15.6f</td>
</tr>
<tr>
<td>9</td>
<td>LAT_INC</td>
<td>Double</td>
<td>Latitude interval</td>
<td>%8s%15.6f</td>
</tr>
<tr>
<td>10</td>
<td>LONG_INC</td>
<td>Double</td>
<td>Longitude interval</td>
<td>%8s%15.6f</td>
</tr>
<tr>
<td>11</td>
<td>GS_COUNT</td>
<td>Integer</td>
<td>Grid node count</td>
<td>%8s%6d</td>
</tr>
</tbody>
</table>

Figure B6 – Sample Sub Grid Overview

<table>
<thead>
<tr>
<th>SUB_NAME</th>
<th>PARENT</th>
<th>CREATED</th>
<th>UPDATED</th>
<th>S_LAT</th>
<th>N_LAT</th>
<th>E_LONG</th>
<th>W_LONG</th>
<th>LAT_INC</th>
<th>LONG_INC</th>
<th>GS_COUNT</th>
</tr>
</thead>
</table>

Table B4 specifies the values at each grid node and a sample is given in Figure B7. The number of nodes in this section of the file is specified in the Sub Grid Overview value GS_COUNT. At each node, only the four values specified are stored, i.e. no identifier or coordinate information is stored.

(Note: The shift values at each node consist of a conformal transformation component and a distortion component. If the distortion component at the node cannot be modelled, e.g. because of insufficient data, then the shift value at the node contains the conformal component only. When this occurs, both of the accuracy values are set to -1 to denote this. These nodes can still be used.
in the interpolation of shift values, however it is not possible to interpolate the accuracy of the shifts).

Table B4 – Sub Grid Node Values

<table>
<thead>
<tr>
<th>Record</th>
<th>Identifier</th>
<th>Value</th>
<th>Description</th>
<th>ASCII format</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Float</td>
<td>Latitude shift value</td>
<td>%10.6f</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Float</td>
<td>Longitude shift value</td>
<td>%10.6f</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Float</td>
<td>Latitude shift accuracy</td>
<td>%10.6f</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Float</td>
<td>Longitude shift accuracy</td>
<td>%10.6f</td>
<td></td>
</tr>
</tbody>
</table>

Figure B7 – Sample Sub Grid Node Values

5.414650 -4.727520 0.002171 0.000617
5.413610 -4.728820 0.001615 0.000235
5.413050 -4.729720 0.001563 0.000233

B.3 Necessary Considerations for NTv2 Usage

As previously discussed, the NTv2 file format was adopted for use as a standard format for transforming coordinates from AGD to GDA94 within Australia. Since the initial implementation of the NTv2 file format for Australian use, there has been a revised NTv2 file format (Canadian Binary file) produced which will supersede the original Australian Binary file. The following sections clarify the differences between the revised Canadian Binary file and the original Australian Binary file, and note the necessary considerations for the usage of the NTv2 format outside Canada.

B.3.1 Difference Between Australian and Canadian Binary Files

NTv2 files can exist in two forms, binary and ASCII. In Australia the only version of a grid shift file that strictly adheres to the NTv2 file format is the ASCII version (States only distribute the binary form, but the ASCII equivalent is easily obtained from utilities such as GDAit). The differences in the binary form are minor but the consequence is that there are two binary forms of an NTv2 file that aren’t compatible: an Australian version and a Canadian version. Only the Canadian version is a true NTv2 file. The following explains the difference between the two binary forms and outlines the reason why it occurred.

What is the difference?

The simple answer is that any integer value in a Canadian NTv2 binary file must be read as a 4 byte number followed by 4 bytes of padding. Australian binary files DON’T contain this padding, Canadian binary files do. This affects three records in the Overview Header (NUM_OREC, NUM_SREC and NUM_FILE), and one record in each of the Sub-grid Headers (GS_COUNT).

Considering this in more detail, an NTv2 file is comprised of an Overview Header and is followed by one or more Sub-grids. This is represented in Figure B8.
Figure B8 – NTv2 File Structure

<table>
<thead>
<tr>
<th>Overview Header</th>
<th>Sub-grid 1: Header</th>
<th>Sub-grid 1: Node Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sub-grid N: Header</td>
<td>Sub-grid N: Node Values</td>
<td></td>
</tr>
</tbody>
</table>

The Overview Header and each Sub-grid Header consist of 11 records of 16 bytes, i.e. each header is 176 bytes long. The first 8 bytes of each record is a string identifier, the last 8 bytes contain the value of the identifier. The value can be one of three data types: an integer, a double or a string. A representation of how each data type is stored in an NTv2 header record is shown in Figure B9 with the number of bytes required being given in brackets.

Figure B9 – Data Storage in a Header record

<table>
<thead>
<tr>
<th>Double: Identifier (8)</th>
<th>Value (8)</th>
</tr>
</thead>
<tbody>
<tr>
<td>String: Identifier (8)</td>
<td>Value (8)</td>
</tr>
<tr>
<td>Integer: Identifier (8)</td>
<td>Value (4)</td>
</tr>
</tbody>
</table>

The padding used for integer values is 4 NULL characters (ASCII character 0). The only purpose of the padding is to make a record with an integer value 16 bytes long, all other data types will automatically have records 16 bytes long. The records affected in the Overview Header (see Table B2) are NUM_OREC, NUM_SREC and NUM_FILE. The record affected in the Sub-grid Header (see Table B3) is GS_COUNT.

The format of the “Node Values” in a Sub-grid is identical for both Australian and Canadian binary files, i.e. no padding is used. For more information about the NTv2 file format refer to Appendix B.2 NTv2 File Format.

Why did the difference occur?

Australian binary came into existence because it was believed that NTv2 binary was compiler dependent. The Canadians had implemented it with FORTRAN and information at the time suggested that the use of records within a FORTRAN binary file would create a file that other development environments would have difficulty reading and writing. Given that most software development today is done in a language other than FORTRAN, the decision was made to format the file as specified in Appendix B of the NTv2 Developer’s Guide (Junkins and Farley, 1995), but to ignore any auxiliary record identifiers that FORTRAN used. At the time this was not considered to be a major issue. A FORTRAN version of the grid file could easily be created for those who required it by using a FORTRAN utility to convert an ASCII version of the grid file to the binary form.

However it was apparent that NTv2 binary was not compiler dependent. The justification for having
an Australian version of the binary is no longer valid and retaining it will lead to further confusion in the future. Ultimately, the best option is to abandon this version and adopt the Canadian implementation.

**B.3.2 Implications of Using NTv2 Outside Canada**

NTv2 was developed for use in Canada and therefore regards longitude as increasing *Positive West*, which is opposite to the convention used in Australia of *Positive East* longitudes. The implication of this is that longitude values that are east of Greenwich (all Australian longitudes), must be made negative to be compatible with a *Positive West* system. (Latitude values do not need to be modified as they are considered as *Positive North* in NTv2 which is the standard convention).

*Figure B10 – Longitude Axis Orientation*

![Longitude Axis Orientation](image)

The sign reversal of the longitude axis explains why the sub grid parameters Upper and Lower Longitude in Figure B10 appear in the order they do. The Lower Longitude value is the smallest or most negative longitude, Upper Longitude is the largest, or least negative value.

**References**


APPENDIX C – GDAy 2.1 SOFTWARE LICENSE AGREEMENT

This GDAy 2.1 Software License Agreement is a legal agreement between THE STATE OF QUEENSLAND represented by the Department of Natural Resources and Mines (the Licensor) and you, the end user of GDAy 2.1 (the Licensee), whereas:

- The Licensor has developed and is the owner of the intellectual property rights in the GDAy 2.1 Software.
- The Licensor agrees to grant a non-exclusive, non-transferable Licence to the Licensee.

IT IS AGREED:

1. DEFINITIONS

- ‘Agreement’ means this Deed of Agreement between the parties;
- ‘Software’ means the GDAY Software provided by the Licensor to the Licensee;
- ‘Intellectual Property Rights’ means all rights in copyright, patents, registered and unregistered trademarks, registered designs, trade secrets, knowhow, rights in relation to circuit layouts and all other rights of intellectual property as defined in Article 2 of the Convention establishing the World Intellectual Property Organisation of July 1967;
- ‘Licence’ means the non-exclusive, non-transferable licence granted by the Licensor to the Licensee pursuant to this agreement.

2. ENTIRE AGREEMENT

2.1 This Agreement constitutes the entire agreement between the parties. Any prior arrangements, agreements, representations or undertakings are superseded. No modification or alteration of any clause of this Agreement will be valid unless it is in writing signed by each party.

3. LICENCE

3.1 The Licensor grants a licence to the Licensee to use the Software on and from the date of this agreement.

3.2 The use of the software shall be limited to personal use or for use in the ordinary course of business. The licensee must not sell the Software (or any part of it) or distribute it (for reward) to any other third party nor produce hardcopy products incorporating the Software except with the prior written consent of the Licensor.

3.3 The Licensee shall acknowledge on any electronic or hard paper copy documents produced that the Software was made available by the State of Queensland through the Department of Natural Resources and Mines.
4. DURATION OF LICENCE

4.1 The Licensor and the Licensee agree that the Licence shall remain in force from the date of receiving this Software Agreement until the termination of this Agreement.

5. STATUS OF LICENSEE

5.1 The Licensee is not partner or agent of the Licensor and does not have the power or authority, directly or indirectly or through its servants or agents, to bind the Licensor to any agreement with a Licensee or other third party or otherwise to contract, negotiate or enter into a binding relationship for or on behalf of the Licensor.

6. CONFIDENTIALITY

6.1 The Licensee agrees that the Software is valuable commercial information of the Licensor.

6.2 The Licensee agrees to disclose the Software only to such of its employees, servants and contractors who need to know it for the purpose of the Licensee exercising its rights under this Agreement.

6.3 The Licensee shall take all reasonable steps to maintain and safeguard the confidentiality of the Software and to ensure that its employees, servants, contractors, consultants, clients and business associates, maintain the confidentiality of the Software and use the Software solely for the purposes permitted under the Agreement.

7. INTELLECTUAL PROPERTY

7.1 Both Parties agree and acknowledge that the Licensor is the owner of, the Intellectual Property Rights of and related to the Software.

7.2 Except where expressly permitted in this Agreement, the Licensee must not make any use of the Software which is not referred to in this agreement.

7.3 These conditions do not confer on the Licensee any rights of ownership in the Software.

8. WARRANTY

8.1 The Licensor warrants that it has the full right, power and authority:

- To enter into this agreement; and

- To grant to the Licensee all rights which are conferred upon the Licensee under this Agreement.
8.2 The Licensee acknowledges that the Licensor does not guarantee the accuracy or completeness of the Software or that it is free from error, and other than the warranty contained in clause 8.1 does not make any other warranty about the Software.

9. LIMITATION OF LIABILITY

9.1 Except as expressly provided to the contrary in this Agreement, the Licensor shall not be under any liability to the Licensee in respect of any loss or damage (including consequential loss or damage) however caused, which may be suffered or incurred or which may arise directly or indirectly in respect of the supply of the Software pursuant to this Agreement or the failure or omission on the part of the Licensor to comply with its obligations under this Agreement.

9.2 Except as expressly provided to the contrary in this Agreement, all warranties, whether express, implied, statutory or otherwise, relating in any way to the subject matter of this Agreement or to this Agreement generally, are excluded. Where any Act of Parliament implies in this Agreement any term, and that Act avoids or prohibits provisions in a contract excluding or modifying the application of or exercise of or liability under such term, such term shall be deemed to be included in this Agreement. However, the liability of the Licensor for any breach of such term shall, if permitted by that Act be limited, at the option of the Licensor, to the replacement of the Software.

9.3 The Licensee warrants that it has not relied on any representation made by the Licensor which has not been stated expressly in this Agreement, nor has it relied upon any descriptions or illustrations or specifications contained in any document produced by the Licensor.

9.4 The Confidentiality clause 6, Warranty clause 8, Limitation of Liability clause 9, and Indemnity clause 10, shall continue to have full force and effect following termination of this agreement.

9.5 The Licensor shall not be under any liability to the Licensee in respect of any loss or damage (including consequential loss or damage) howsoever caused which may be suffered or incurred or which may arise directly or indirectly in respect of the use of the Software.

10. INDEMNITY

10.1 The Licensee shall indemnify and hold the Licensor harmless from and against any and all action, losses, damage, judgments, awards, settlements and expenses, directly or indirectly arising from or connected with any claim, demand, law suits or legal proceedings arising out of the accuracy of the Software or any work produced from the Software, the use made by any third party of the Software or the unauthorised use by the Licensee of the Software.

10.2 The Licensee shall be solely responsible for the use, supervision, management and control of the Software.
10.3 The Licensee shall ensure that the Software is protected at all times from access, use or misuse, damage or destruction by any person not authorised by the Licensor or Licensee for that purpose.

11. OBLIGATIONS OF THE LICENSEE

11.1 The Licensee shall notify the Licensor immediately if the Licensee becomes aware of any unauthorised use of the whole or part of the Software by any person.

12. TERMINATION OF THE LICENCE

12.1 In the event that the Licensee fails to perform any of its obligations or responsibilities under this Agreement the Licensor may terminate this Licence forthwith upon written notice to the Licensee.

12.2 The parties agree that upon termination of this Agreement all rights granted by the Licensor to the Licensee shall cease immediately.

12.3 The parties agree that termination of this Agreement by the Licensor shall not derogate from or prejudice any other rights of the Licensor against the Licensee in respect of anything done or omitted to be done by the Licensee under this Agreement.

12.4 The Licensee agrees that upon termination of this Agreement the Software shall be returned to the Licensor and all copies shall be erased from all forms of storage. The Licensee shall provide a written certificate to the Licensor specifying either that the Software has been destroyed, returned or otherwise, as directed by the Licensor.

13. APPLICABLE LAW

13.1 The parties hereby agree that this Agreement shall be governed by and construed in accordance with the law of the State of Queensland.

14. ASSIGNMENT

14.1 Neither this Agreement nor any rights granted hereunder may be assigned or sub-licensed in any manner whatsoever by the Licensee.

15. WAIVER

15.1 None of the conditions of this Agreement shall be waived, varied, discharged or released whether at law or in equity, unless both parties agree in writing.